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Preface 

Overview 

Thank you for choosing our medium and large-scale PLC. 

This manual contains the information necessary for using the medium and large-scale PLC. Please read this 

manual carefully before use to fully understand the functions and performance of the product, and 

complete system construction, which helps to give full play to the product's superior performance. 

Target Audience 

This manual is intended for personnel with professional knowledge of electrical engineering (e.g., qualified 

electricians or personnel with equivalent knowledge). 

Scope of Application 

This manual is applicable to the TM and TP series PLCs. 

Online Support 

This manual is not delivered with the product. To obtain an electronic version of the PDF file, you can: 

Visit our website (www.invt.com), choose Support→Download, enter a keyword, and click Search. 

Scan the QR code on the product housing→Enter a keyword and download the manual. 

Revision History 

Due to product version upgrades or other reasons, this manual is subject to changes from time to time 

without prior notice. 

Number Revision Description Version Release Date 

1 First release. V1.0 September 2024 

 

 

 

https://www.invt.com/
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1 Introduction to the PLC 

1.1 Overview 

1.1.1 Product Overview 

INVT’s medium and large-scale PLCs currently include two series: TM700 and TP6000, which follow the IEC 

61131-3 programming language system and support six standard programming languages: IL, LD, FBD, ST, 

SFC, and CFC. Through the EtherCAT bus, they can realize high-level motion control functions such as 

electronic cam, electronic gear, synchronous control, and positioning. Owing to rich communication 

interfaces and versatile I/O modules, they can provide users with flexible and intelligent automation 

solutions to meet their diverse application needs. 

The TM700 series is a high-performance PLC with a modular structure design. It is mainly used in scenarios 

with high motion control requirements and complex control networks. It has greatly improved control 

performance, communication capabilities, programming efficiency, etc., allowing you to build a control 

network more flexibly and realize data interaction with the information layer through OPC UA more 

conveniently, further improving device productivity, shortening development cycles, and bringing a more 

excellent experience. 

The TP6000 series is based on the X86 architecture and EtherCAT bus technology, and meets the needs of 

high-standard on-site control systems with extremely high performance and rich interfaces and functions. 

The dual EtherCAT interfaces can realize multi-tasking and ring network control, thereby bringing more 

reliable solutions. It is widely used in various high-speed, high-precision, and high-response devices and 

medium and large-scale production lines. 

1.1.2 Product Specifications 

Model TM750 TM751 TM752 TM753 TP6210-1201 TP6211-2201 TP6214-2201 

Rated working 

voltage 
DC24V (-15%–+20%) 

Memory 

Program 

capacity 
20 MB 256 MB 

Data capacity 64 MB 256 MB 

Data capacity in 

power failure 

retention mode 

1 MB 5 MB 

Max. capacity of 

expanded SD 

card 

32G - 

I/O 

Number of local 

IO modules 
16 - 

High-speed 

input 

4 groups of high-speed counters, 

supporting single phase, phase A/B, 

CW/CCW, and pulse+direction, of which 

2 groups of phase AB or 1 group of ABZ 

differential input 
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Model TM750 TM751 TM752 TM753 TP6210-1201 TP6211-2201 TP6214-2201 

phase A/B supports 1x, 2x, and 4x 

frequencies. 

High-speed 

output 

8-channel 200kHz sink-type high-speed 

output, supporting 4-axis pulse motion 

control 

- 

Support for I/O 

interruption 
8-channel high-speed interruption - 

PWM output 4-channel PWM output - 

Communication Network and Interface 

Ethernet 

 2, RJ45, 100Base-TX 

Support for PLC software download, Modbus TCP, TCP// IP, OPC UA protocol, and 

EtherNet IP 

EtherCAT 
 1, RJ45, 100Base-TX, distance between 

two slaves ＜ 100 m 

 2, RJ45, 100Base-TX, 

distance between two 

slaves ＜ 100 m 

 2, RJ45, 

support for 

dual masters, 

100Base-TX, 

distance 

between two 

slaves ＜ 

100 m 

Serial 

communication 

(RS485) 

 2, Modbus RTU master/slave, plug-in terminal 

USB 
 1, Type-C, PC communication, program 

download and debugging 
 4, USB 3.0, file copy 

Memory card  1, Micro SD, for upgrading applications x x x 

Communication 

expansion 
CANopen, 4G, Wi-Fi x x x 

Motion Control 

Maximum 

number of 

controlled axes 

4 8 16 32 64 128 256 

Motion control 

functions 

Point-to-point motion, interpolation motion (straight line, circular arc, etc.), 

electronic gear, electronic cam (flying shear, tracking shear, etc.), axis group, CNC, 

etc. 

Configuration Programming 

Programming 

language 
IL, ST, FBD, LD, CFC, and SFC 

 

1.1.3 Product Configuration and Module Description 

The TM700 series's CPU can be directly connected to the Flex series I/O modules, or expanded to the Flex 

series I/O modules through a communication coupler, as shown in the figure below. 
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Figure 1-1 System Integration Diagram 1 

 

The TP6000 series’s CPU cannot be directly connected to the Flex series I/O modules. It can only be 

expanded to the Flex series I/O modules through a communication coupler, as shown in the figure below. 

Figure 1-2 System Integration Diagram 2 
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1.1.4 System Application Process 

 

1.2 Invtmatic Studio Overview 

Invtmatic Studio is a programming platform developed by Shenzhen INVT Electric Co., Ltd. It supports the 

IEC 61131-3 programming language system and six standard programming languages: IL, LAD, FBD, SFC, ST, 

and CFC. 

1.2.1 Software Installation and Uninstallation 

1.2.1.1 Software Obtaining 

INVT's PLC user programming software contains the Invtmatic Studio platform, installation files, and related 

reference materials. You can obtain them by the following ways: 

1. Visit our website www.invt.com and go to Support > Download > Software to download the software 

installation package for free. 

2. Obtain software installation CDs from INVT distributors at all levels. 

1.2.1.2 Software Installation Requirements 

You can install the software on a desktop PC or a laptop: 

 Operating system: Windows 7/Windows 8/Windows 10 

 CPU clock speed: 2 GHz or higher 

 Memory: 2 GB or higher 

 Available hardware space: 5 GB or higher 

 Installation requirements: 

 Use an administrator account  

 Turn off the antivirus software  

 Disable the encryption system  

 Do not use Chinese paths 

1 
•Install the CPU and required expansion modules. 

2 
•Wire and connect the related modules. 

3 

•Turn on the power only after confirm that the wiring of each module 

is correct and the power supply voltage meets the specifications. 

4 

•Connect the computer that hosts Invtmatic Studio to the CPU 

module. 

5 

•Download the program created on Invtmatic Studio and related 

parameters to the CPU module. 

6 

•Ensure that the Nixie tube of the CPU module does not show any 

fault code and the fault indicators of all modules do not turn on. 

https://www.invt.com/
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1.2.1.3 Preparation 

 If it is the first time to install Invtmatic Studio, check whether your computer meets the software 

installation requirements. If yes, you can install it directly. 

 If you want to install the latest version of Invtmatic Studio, check the version information about the 

installed software by choosing Help > About. If it is not the latest version, you can upgrade the 

software using the online upgrade method. 

Figure 1-3 Version Information Display Interface 

  

1.2.1.4 Installing the Software 

Step 1 Locate the installation file storage path, and double-click Invtmatic Studio Setup 64 Vx.x.x.exe 

(taking V1.3.5 as an example). 

Step 2 The installation starts. See the following figure. 

Figure 1-4 Installation Preparation interface 

 

Step 3 When the dialog box shown in the following figure appears, click Next. 
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Figure 1-5 Installation Wizard Interface 

 

Step 4 Then the License Agreement dialog box appears. Check I accept the terms of the license 

agreement, and then click Next. 

Figure 1-6 License Agreement Interface 

 

Step 5 Set the software installation path, and click Next. 

Note: The software installation path cannot be in Chinese. 
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Figure 1-7 Installation Path Confirmation 

 

Step 6 The installation component selection interface appears. You can select the Complete or Custom 

installation mode. If you have no special requirement, keep the default selection, and click Next. 

Figure 1-8 Installation Mode Selection Interface 
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Step 7 When the following interface appears, click Install. 

Figure 1-9 Installation Preparation Interface 

 

Step 8 An installation progress bar appears. Click Finish when the installation is completed. 

Figure 1-10 Installation Progress Interface 
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Figure 1-11 Installation Complete Interface 

 

1.2.1.5 Uninstalling the Software 

Uninstall Invtmatic Studio by using the standard software uninstallation method of a Windows system. The 

procedure is as follows: 

Step 1 Shut down Invtmatic Studio running programs, including the backend running program. 

Step 2 Enter the control panel, find and right-click Invtmatic Studio, and click Uninstall. 

Step 3 Wait until the software is uninstalled. 

1.2.2 Hardware Connection 

The hardware connection between an upper computer and the TM700 series PLC can be realized by two 

methods: 

1. Using a LAN network cable 

2. Using a Type-C cable 

Figure 1-12 Hardware Connection between an Upper Computer and the TM700 Series PLC 

1. Network cable

2. Type-C

 

The hardware connection between an upper computer and the TP6000 series PLC can only be realized 

through a LAN network cable. 
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Figure 1-13 Hardware Connection between an Upper Computer and the TP6000 Series PLC 

Network cable

 

 

1.3 PC Communication Configuration 

1.3.1 PC and TM700 Communication Configuration 

 Using a LAN network cable 

If the hardware is connected with a LAN network cable, ensure that the IP address of the PC and the IP 

address of the controller are in the same network segment. The factory default IP address of the TM700 

series is as follows: Ethernet1: 192.168.1.10; Ethernet2: 192.168.2.10, both having program debugging 

and downloading functions. Please make sure the network cable is connected to Ethernet1/Ethernet2. 

The IP address of the PC should be set to 192.168.1.xxx/192.168.2.xxx (xxx means any integer value in 

the range of 1 – 254 except 10). 

Figure 1-14 PC and TM700 Communication Configuration Using a LAN Network Cable 
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 Using a Type-C cable 

 Install the USB driver 

When the PC runs Windows 10, install the USB driver as follows: 

Here we take the USB driver file of kindle_rndis.inf_amd64 as an example. 

Step 1 Right-click the file "RNDIS_Windows_Driver.cab" and unzip it. 

 

Step 2 When the following interface appears, press any key. 

 

Step 3 Connect the computer and the PLC with a USB cable: Open Device Manager, select Ports > 

USB serial device, and right-click Update driver. 

 

Step 4 Click Browse my computer for drivers and select the driver folder. 
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Step 5 Wait for the installation process to complete, and then click Close. 
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 Configure the USB network port 

The USB RNDIS item has been added to the Network adapters under Device Manager. 
  

 

Step 1 Right-click the Ethernet. 
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Step 2 Click Change adapter options. 

 

Step 3 Right-click the Unidentified network (with USB RNDIS in its name), and select Properties. 

 

 

Step 4 Check Internet Protocol Version 4 and click Properties to set the IP address. 
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Step 5 Set the IP address manually. 

Note: The IP address must be in the network segment 192.168.3.xxx (xxx means any integer value in 

the range of 1 – 254 except 10). 

 

1.3.2 PC and TP6000 Communication Configuration 

If the hardware is connected with a LAN network cable, ensure that the IP address of the PC and the IP 

address of the controller are in the same network segment. The factory default IP address of the TM700 

series is as follows: Ethernet1: 192.168.1.10; Ethernet2: 192.168.2.10, both having program debugging and 

downloading functions. Please make sure the network cable is connected to Ethernet1/Ethernet2. The IP 

address of the PC should be set to 192.168.1.xxx/192.168.2.xxx (xxx means any integer value in the range of 1 

– 254 except 10). 

Figure 1-15 PC and TP6000 Communication Configuration Using a LAN Network Cable 
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2 Getting Started 

2.1 Project Creation 

2.1.1 Starting the Programming Environment 

Taking Invtmatic Studio V1.3.5 as an example, start the programming environment in the following steps: 

Step 1 Double-click the software icon of Invtmatic Studio . The programming environment is as follows: 

 

 

Step 2 In the tool bar, select Tools > Device Repository to add a device profile. 

Note: Invtmatic Studio V1.3.5 is installed with the INVT device profile by default. For third-party devices, it 

needs to be added manually. 
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Step 3 In the Device Repository pop-up window, click Install. 

 

 

Step 4 From the pop-up window, select the device profile to be installed from a local folder and then click 

Open. 

 

Note: Here you can follow the above steps to add all device profiles provided by INVT, or add third-party 

device profiles. 
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2.1.2 Creating a New Project 

Click the project creation icon  at the upper left corner or select File > New Project, or directly click 

New Project in the window to quickly create a project. Select the project category, template, name, and 

storage directory, as shown in the following figure. 

 

 

Click OK. On the standard project setting interface that appears, select the device type and programming 

language. 

 

After completing the above operations, go to the configuration and programming interface of Invtmatic 

Studio, double-click PLC_PRG(PRG) to write programs. 
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2.2 Typical Steps of Project Writing 

From the above example given in section 2.1.1 Starting the Programming Environment, writing a user 

program with MC motion control functions generally requires the following steps: 

Step 1 Application system hardware configuration 

Configure the network according to the main controller, expansion modules, network type, servo slave, and 

other hardware used. 

Step 2 User program writing 

According to the control function to be implemented, write motion control with one POU (such as POU1), 

and write common logic control with another POU (such as POU2). 

Step 3 Servo drive parameter configuration 

Configure the objects of SDO and PDO according to the servo name and running mode in the hardware 

configuration, and ensure that the communication objects required between the MC function block of the 

user program and the servo are filled in the configuration table. 

Step 4 Servo motor parameter configuration 

Correctly fill in the resolution of the servo motor encoder, the transmission ratio of the mechanical structure, 

the characteristics of the axis movement range, and other parameters so that the displacement instruction 

imposed on the control object corresponds accurately to the actual displacement. 

Step 5 Task arrangement 

Based on the real-time requirements of control, execute the motion control function POU1 in the EtherCAT 

task; set the cycle to 500 μs, 1 ms, 2 ms, or 4 ms and make it the same as the EtherCAT master 

synchronization cycle, with the priority of 0; execute the common logic control POU2 in MainTask or other 

common tasks and set the cycle to 1 ms, 4 ms, or 20 ms, with the priority of 1. 

Step 6 Online debugging 

Connect the TM Series PLC to the PC via a LAN network cable correctly and then power on the PLC. 

Download and debug the user program to eliminate user program bugs (if possible, you can connect the 

servo drive system to the TM series PLC, and then perform debugging. If the servo system is not available, 

you can set the servo drive system as a virtual axis; if the TM series PLC is not available, you can simulate and 
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debug the user program on the PC to eliminate possible errors in the user program until it is compiled 

without errors). 

2.3 Examples of Program Writing and Debugging 

Here is an example of a basic servo control program to give you a first glimpse of the programming process 

before you go through the principle of the programming system and the method of compiling the motion 

control program. Write a simple program that allows the TM series PLC to implement the following functions: 

the servo motor repeats rotating forward 50 revolutions, and then reversing 50 revolutions. 

The programming method and steps are as follows: 

Step 1 Add the corresponding devices: EtherCAT master, servo drive, and motor shaft. 

Step 2 Handle the motion control of the servo in the high real-time EtherCAT task cycle. 

Step 3 Set relevant parameters. 

Step 4 Write the program. 

2.3.1 Adding a Device 

Step 1 Right-click Device in the device tree of the software interface, select Add Device and then 

Fieldbuses > EtherCAT > Master > EtherCAT Master SoftMotion (corresponding master), and click 

Add Device. 
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Step 2 Double-click Device on the left side of the software interface, and click Scan for Network on the 

pop-up window. When the PLC light on the right is green, it indicates the PLC device is connected 

successfully and you can download the PLC program. 
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Step 3 Add a slave. 

There are two methods to add a slave: automatic scanning for device configuration, and offline device 

configuration, which are introduced below respectively. 

 Automatic scanning for device configuration 

Usually, after the PLC and EtherCAT devices are powered on and the EtherCAT bus has connected EtherCAT 

devices such as the servo motor and IO modules, the bus devices are scanned by software to automatically 

complete the configuration. The operation steps are as follows: 

Step 1 Right-click the required master device in the device tree and select Scan For Devices, as shown in 

Figure 2-1. Then, the slave devices can be scanned and the scanning result window will pop up, as 

shown in Figure 2-2. 
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Figure 2-1 EtherCAT Master Scanning Interface 

 

Step 2 Click Copy to project on the Scan Devices interface. The servo drive and the corresponding 402 axis 

will be automatically added. 

Note: INVT servo motors do not require manual axis addition later, but third-party servo motors require it. 

Figure 2-2 Adding a Slave to the EtherCAT Master 

 

 

 Offline Device Configuration 

If the network connection for the PLC, the servo motor, and other devices is not available, you can 

perform device configuration directly on the Invtmatic Studio software. 
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Right-click EtherCAT_Master_SoftMotion in the device tree, and select Add Device. 

Figure 2-3 Adding an EtherCAT Slave Offline 

 

 

Figure 2-4 Selecting an EtherCAT Slave Device 

 

After the servo slave and 402 axis are added to EtherCAT, it is shown as below. 
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2.3.2 Writing a Function to Handle POUs 

In Invtmatic Studio programming environment, there is an EtherCAT_Task task and a MainTask task for the 

default task configuration. The MainTask task contains a POU named PLC_PRG which is created when the 

new project is created, as shown in Figure 2-5. We need to create a POU dedicated to servo control and put it 

under the EtherCAT_Task task. The creation steps are as follows: 

Figure 2-5 PLC_PRG Programming Interface 

 

 

Step 1 Right-click Application in the device tree, select Add Object > POU, and add a POU dedicated to 

EtherCAT servo control. 
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Step 2 Double-click EtherCAT_Task in the device tree, click Add Call on the configuration interface, and 

select a POU. 

Figure 2-6 Calling a POU for the EtherCAT task 
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2.3.3 Setting Motor Parameters 

For precise control of the movement position, the PLC must accurately calculate the position of the servo 

motor. Based on the operating characteristics and stroke characteristics of the application system, as shown 

in the figure below, select Axis type and limits so that the PLC can calculate the feedback information from 

the motor encoder to obtain the accurate position and avoid errors caused by the accumulation of encoder 

pulses. 

Figure 2-7 Motor Parameter Settings 

 

Note: 

 For the reciprocating mechanism of the lead screw type, Finite is preferred as the lead screw stroke is 

limited and we should know its absolute position within the stroke range. 
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 For a single-direction axis, Modulo is preferred as the linear mode may cause position counting 

overflow, resulting in position calculation errors. 

The encoder parameters of the motor (such as resolution) and the mechanical reduction ratio of the 

application system may be different. They need to be set based on the actual situation during programming, 

as shown in the following figure. 

Figure 2-8 Motor Encoder Parameter Settings 

 

 

When the motor is running, the PLC sends the required number of pulses to the servo drive through 

EtherCAT communication to control the servo operation. Therefore, the encoder resolution needs to be 

accurately set according to the actual situation. For example, if the resolution of the servo motor is 20 bits, it 

means that for the motor to make one revolution, 1,048,576 pulses need to be received. 

You need to set the corresponding parameters (electronic gear ratio) according to the actual mechanical 

structure. 

Note: Please note that only integer values can be entered for the parameters shown in the above figure. In 

order to ensure that the ratio of the parameters in the corresponding rows on the left and right sides is 

effective, you can adjust the integer values on the left and right sides appropriately. For example, a 20-bit 

servo motor drives a lead screw of 16 mm (the screw slider moves 16 mm when the screw rod rotates 1 circle) 

after passing through a mechanical reduction mechanism with a ratio of 3.75:1. The parameter settings are 

shown in the figure below. 

Figure 2-9 Parameter Setting Example 
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2.3.4 Writing a Function for Forward/Reverse Motor Direction Control 

For the motion control of the servo axis, the default synchronization period is 4 ms, and you can select it 

according to actual needs, as shown in the figure below. 

Figure 2-10 Servo Axis Motion Control Cycle Setting 

 

The program in the figure below is written in the ST language, and the relevant code is as follows. 

Figure2-11 ST Code 

 

 

2.3.5 Compiling the User Program 

If there is a writing error, the error type and reason will be listed in Figure2-11. Once you double-click the 

error description, the cursor will jump to the corresponding program editing window to facilitate revision. 

After the revision, compile it again until all compilation problems are eliminated. The operation steps are as 

follows: 



INVT Medium and Large-scale PLC Software Manual  Getting Started 

202409 (V1.0)  30 

Step 1 Double-click Device in the device tree, and select Communication Settings > Scan Network. 

Step 2 After selecting the corresponding device, click Flash. At this time, the RUN and ERR lights of the 

connected device will flash three times. 

Step 3 After confirming the device, download the user program to the CPU module. 

Figure 2-12 Program Compilation Interface 

 

 

Figure 2-13 Connecting to the PLC 
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Figure 2-14 User Program Download 

 

 

2.3.6 Running the Monitor Program 

As shown in Figure 2-14, after logging in to the device, you can know the program is running by observing 

the actual operation of the servo or checking the position value of the servo axis of the upper computer. At 

this point, the required servo jogging and 2-cycle running triggering functions have been implemented, 

which means the programming process is complete. You can also view the CPU and memory usage in the 

lower left corner of the interface, as shown in Figure 2-15. In the task configuration interface, you can view 

the execution cycle time of each task (after the program is powered on for the first time, you need to 

right-click and select Reset to view the accurate time), as shown in Figure 2-16. 

Figure 2-15 Device Monitoring 
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Figure 2-16 Task Monitoring 
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3 Basic Functions 

3.1 Interface Layout 

Search in the Start menu of the Windows system or click the shortcut on the desktop to open the Invtmatic 

Studio software. 

Figure 3-1 PLC Project Interface of Invtmatic Studio 

 

The interface mainly includes the following content: 

 PLC device information, you can right-click Device to change the PLC model; 

 Application, i.e. the user program management unit; 

 EtherCAT_Task, i.e. the EtherCAT bus task; 

 MainTask, i.e. the main program task; 

 Local module configuration TM75x-HSIO; 

 EtherCAT_Master_SoftMotion, i.e. the EtherCAT bus configuration; 

 EtherCAT bus slave (INVT_DA200_265) and 402 axes, or remote IO modules. 

 Shortcut keys for compilation, login, and debugging. 

3.2 Compile Menu 

The Compile menu integrates diverse functions such as compilation and clearing, which are described as 

follows: 

 Compile: Compile and link all codes into those that can be executed by the PLC. 

 Recompile: Clear the last compiled information and re-execute the compilation instruction. 
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 Generate Code: For the Generate File function required for symbol configuration in label 

communication, you can click the Compile button to implement it, or click the shortcut key . 

 Generate Runtime File: used for R&D testing.  

 Clear: Clear the last compiled and downloaded information.  

 Clear All: Clear compiled information, downloaded information, and reference information, and refresh 

all library and project data compilation information.  

Figure 3-2 Compile Menu 

 

 

3.3 Variable Usage Table 

3.3.1 Overview 

The variable usage table has the following functions: 

 Display the address usage of I/Q/M areas, including the classified display of used addresses, conflicting 

addresses, and free addresses. 

 Display the used size, available size, and usage rate of the program area, data area, power failure 

retention area, and I/Q/M areas. 

3.3.2 Function Introduction 

Select Device > Variable Usage in the device tree and double click Variable Usage to open the interface as 

shown in the figure below. 

Note: The maximum storage capacities of the TM series program area, the data area, the power failure 

retention area, the M area, the I area, and the Q area are 20M, 64M, 1M, 5M, 128K, and 128K, respectively. 
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Table 3-1 Description of Variable Usage 

Number Item Description 

1 
Data refresh 

area 

If you click the Compile button, the interface will extract the information 

it needs based on the generated data and conduct a refresh once the 

compilation is succeeded. Alternatively, you can click the menu Compile > 

Generate Code in Figure 3-2 to trigger an interface refresh. 

Note: This function will refresh the interface only after successful 

compilation. 

2 

Area usage 

information 

area 

It mainly displays the basic information of the program area, data area, 

power failure retention area, and I/Q/M areas, including the total capacity 

of the area, the size of the used area, the size of the available area, and the 

area utilization rate. 

3 

Detailed 

I/M/Q area 

usage 

information 

and function 

block 

information 

display area 

It displays the address usage of I/M/Q areas, including address-associated 

variable information, address conflict status, information of unused 

address areas, etc. 

The function block information mainly includes the type and size of the 

function block called in the program. It also supports functions such as 

search, address range setting, and page number positioning. 

 

The information display interface is shown in the figure below. It is divided into 4 display options, 

namely %M area, %I area, %Q area, and Function block size, which display the usage information of the 

corresponding areas respectively. 
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3.3.3 Menu Options 

Menu options include display options, query, address range settings, and page turning options. 

Table 3-2 Description of Variable Usage Statistics Menu 

Number Item Description 

1 
Display 

options 

For the %M area, %I area, and %Q area, the status options include All, In 

use, System use, Conflict, and Idle; 

For the Function block size, the status options include All, Function block, 

Union, Structure, and Alias. 

2 
Query 

options 

You can perform character matching on the names in the four columns of 

Address, POU, Variable name, Variable type, and Address range. If any 

one of them matches, the condition is met. 

Note: Any changes in the query options will trigger a table refresh. 

3 

Address 

range 

settings 

You can check the address range set by you according to actual needs, and 

the range cannot exceed the limit of the corresponding area. You need to 

click the Query option to enable the range display. 

Note: This item is not available in the function block size interface. 

4 

Page 

turning 

options 

To ensure the table refresh performance, you can add a maximum of 1,000 

address segment units by default. When the data exceeds 1,000 address 

segment units, the system will use paging display. You can click Previous 

Page/Next Page or enter a specified page number, and the system will jump 

to the corresponding page. 
 

Table options: They mainly display the usage information of address segments that meet the filter 

conditions. 

Table 3-3 Description of Variable Usage Statistics Table 

Number Item Description 

1 Address 

The address area is displayed in ascending order, with the smallest unit 

being Byte. When the address occupied by a variable does not conflict, it 

will be displayed in the form of an address area (e.g.: %MB0–%MB3). One 
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Number Item Description 

address may be associated with one or multiple variables. When there are 

multiple variables, the address bar will display multiple duplicate 

addresses. 

2 POU All POU names of variables area displayed. 

3 
Variable 

Name 
The variable name associated with the area is displayed. 

4 
Variable 

type 
The variable type is displayed. 

5 
Address 

Range 
The entire address range of the variable is displayed. 

6 State 

The usage of the address area is displayed. When it is used, the status is In 

Use; when there is a conflict, the status is Conflict; when it is free, the 

status is Idle. 

Note: 

 Address conflict detection is performed based on the byte position. 

When different variables use different bits of the same address, the 

system will mark it as an address conflict during detection. The 

specific conflict situation is based on the actual bit usage. 

 When a user-defined variable conflicts with the IO address assigned to 

the device, it only means that the same address is used in multiple 

places. You can determine whether there is a problem based on 

whether the actual function is used. 
 

3.3.4 Direct Address Storage Area 

Different PLCs provide different direct storage areas. For PLC data, the addresses in the %I and %Q areas 

cannot be saved after a power failure, but the addresses in the %M area can still be saved. The TM700 series 

programming system provides a 128kB (Byte) input area (%I area), a 128kB (Byte) output area (%Q area), 

and a 512kB (Byte) storage area (%M area). The first 480kB in the storage area can be used directly by users, 

and the last 32kB is the system area (mainly used as soft components) and should not be used directly by 

users. During programming, you can directly access addresses or define variables and map them to 

addresses for indirect access. The definition of storage areas and the address range used by them are shown 

in the following table. 

Table 3-4 Description of Storage Areas and Address Range Used by Them 

Area Purpose Size Address Range 

I area (%I) 128kB User area 64k Words %IW0–%IW65535 

Q area (%Q) 128kB User area 64k Words %QW0–%QW65535 

M area (%M) 512kB 

User area 240k Words %MW0–%MW245759 

SD components 10000Words %MW245760–%MW255759 

SM components 10000Bytes Words %MB511520–%MB521519 

Reserved 2768Bytes %MB521520–%MB524287 
 

3.4 Fault Diagnosis 

Diagnosis is intended to quickly locate errors that occur during PLC operation and find solutions according 

to the error information and status. The diagnostic interface of Invtmatic Studio can only be obtained and 

displayed after logging in to the PLC. The Invtmatic Studio programming system supports the diagnosis of 
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various communication devices and can generate fault information, offline information, and other 

information according to the actual running status of each communication device. The module types 

involved in fault diagnosis mainly include CPU module, Modbus, ModbusTCP, etc. The Invtmatic Studio 

programming system mainly provides four diagnosis routes: configuration diagnosis, diagnostic information 

list, device self-diagnostic information list, and diagnostic programming interface. All diagnoses are 

obtained through fault code analysis, and the fault codes correspond to the diagnostic programming 

interface. 

Fault diagnosis can be used to display fault information of all devices, and provide detailed description of 

relevant fault information and methods for troubleshooting the causes. It can also provide more detailed 

diagnostic information for special situations. After the device is connected, double-click Fault diagnosis 

summary in the device tree to open the device fault diagnosis interface. 

 

 

The functions of the fault diagnosis interface are described as follows: 

 Device Type Window 

It displays the current fault type and provides the fault display filter function, which can display fault 

information by device type. Device types include CPU module, Modbus module, Modbus TCP module, and 

local module. You can select a different device type, and the diagnostic display list will show the 

corresponding type of diagnosis. All device diagnoses are displayed by default. 

 Description of Interface Options 

 Device Type: Filter a certain type of faulty bus device. 

 Module Name: Filter faulty devices with a specific name. 

 Search: Search for matching fault information based on the device type or module name. 

 Refresh: Used to refresh device fault information. 

 Clear: Clear the fault information in the table. 

 Export to Excel: Export fault information in the table. 

 Fault Information Count: Display the number of faults. 

 Fault Information List: mainly used to display specific module fault information, including device 

type, module name, error code, and error name.  

 Detailed Information window: When a certain piece of fault information is selected in the Fault 

Information List, the detailed information of the fault will be displayed in the detailed information 
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window, which includes three options: Error Details, Troubleshooting, and In-depth Diagnosis. 

Error Details window: Display possible causes of the fault. Troubleshooting window: used to 

provide the specific operation method for troubleshooting. In-depth Diagnosis window: For some 

complex errors, more detailed information is needed to locate them. 

3.5 Automatic Scanning 

If you need to increase the number of IO ports, you can expand the IO module. The steps to add an 

expansion module to the PLC body in the software are as follows:  

Step 1 Open the Invtmatic Studio programming software, create a new project, and select the 

programming language. 

Step 2 Connect to the PLC and scan local expansion modules. You need to log in to the PLC, but you may 

not start it. 

Step 3 Double-click Automatic Scanning in the device tree, and click Scan in the automatic scanning 

interface. Then, the installed extension modules will be automatically scanned in the list. Click Add 

to Configuration in the upper right corner to complete the scanning and configuration addition of 

the expansion module. 

 

3.6 Cross-reference 

The cross-reference function can be used to quickly find the calling location of the target object in the entire 

project. The operation steps are as follows: 

Step 1 Find the object you want to cross-reference, right-click and select Browse > Browse cross 

References:xEnCntCout. 

 

Step 2 View the usage of the “target object” in the entire project from the Cross-reference List under the 

project. Double-click the information in the cross-reference list to jump to the specific usage 

location in the project. 
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3.7 Monitor List 

The Monitor List function can be used to monitor variables and addresses. During program running, the 

Monitor List can be used to view the data type and current value of the monitored variable, and the variable 

can be assigned a value by writing a value. The operation steps are as follows: 

Step 1 Click View > Watch in the Toolbar, and add Watch 1 to the monitor options. 

 

Step 2 Add the variables you want to monitor under the project bar, or right-click Variable and select Add 

to Watchlist. 
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3.8 Sampling Tracking 

Invtmatic Studio can display the trace curve of variable changes during program debugging. The operation 

steps are as follows: 

Step 1 Right-click Application > Add Object > Trace in the project tree. 

 

Step 2 In the pop-up dialog box, fill in a name for the trace curve, such as Trace in the figure below. 

Double-click the trace curve name in the project tree to open the trace curve interface. In the upper 

right corner of the trace curve interface, click Configuration. Then, a dialog box pops up as shown 

below. In the Task Options box, select EtherCAT_Task. 
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Step 3 Click Advanced in the Trace Configuration interface to show the Advanced Trace Settings Interface, 

in which you can set Measure in every n-th cycles as the sampling period and add Trace editor 

buffer size per variable (samples) to extend the tracking time. 

 

 

Step 4 Select IOConfig_Globals > Axis from Variables in the Trace Configuration interface, find the axis 

position variable fActPosition, click OK, and then add the axis speed variable fActVelocity. 
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3.9 Persistent Variable 

3.9.1 Characteristics 

Power failure retention variables can retain their original values after the PLC loses power or the program is 

downloaded. They are often used to define important parameters in the project to prevent the loss of 

important parameters due to sudden power failure of the PLC or program download. The power failure 

retention feature is mainly declared through the attribute keyword PERSISTENT RETAIN. 

Code example for setting a power failure retention variable: 

VAR_GLOBAL PERSISTENT RETAIN 

iVarPers1 AT %MW100: DINT;  

bVarPers AT %MX1.1 : BOOL;  

END_VAR  

The following table lists the response actions of different power failure retention variables after a reset, 

power failure, or other events. 

Table 3-5 Variable Response Actions 

Action VAR 
VAR PERSISTENT RETAIN/ 

VAR RETAIN PERSISTENT 
VAR RETAIN 

Power 

failure 
Initialization Retain the original value 

Retain the original 

value 

Warm reset Initialization Retain the original value 
Retain the original 

value 

Cold reset Initialization Retain the original value Initialization 

Initial value 

reset 
Initialization Initialization Initialization 
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Action VAR 
VAR PERSISTENT RETAIN/ 

VAR RETAIN PERSISTENT 
VAR RETAIN 

Program 

download 
Initialization Retain the original value Initialization 

Online 

modification 

Retain the original 

value 
Retain the original value 

Retain the original 

value 

Note: 

 RETAIN and PERSISTENT RETAIN variables are both persistent variables, but they have different 

characteristics. 

 Direct variables mapped to %M addresses can be declared as persistent variables, while direct 

variables mapped to %I and %Q addresses cannot be declared as persistent variables. 

3.9.2 Power Failure Retention Variable List 

If power failure retention variables are defined in the project, a power failure retention variable list must be 

generated; otherwise, the defined variables will not have the power failure retention function. You can use 

the power failure retention variable list to add power failure retention variables. The operation steps are as 

follows: 

Step 1 Right-click Application in the device tree, select Add Object > Persistent Variables…. 

Step 2 In the pop-up dialog box, enter the name of the power failure retention variable list and click Open 

to open it. 

    

 

You can also declare power failure retention variables directly in the power failure retention variable list, as 

indicated by  in the figure below. However, this method has a disadvantage that it does not support 

variables defined by direct addresses (such as MX0.0). It is recommended to declare the PERSISTENT RETAIN 

or RETAIN keyword in the global variable list, and then right-click a blank area on the interface to select Add 

all Instance Paths to generate an instance path in the power failure retention variable list, as indicated by 

 in the figure below. 

Note: Among the PERSISTENT RETAIN or RETAIN variables declared in the global variable list, at least one 

variable is used in the program before it can be added to the power failure retention variable list. 
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3.10 Recipe Manager 

A recipe is a set of parameter values that provides the information required to produce a product and 

control the production process. For example, the raw materials of biscuits such as sugar, eggs, butter, and 

flour, baking time, and other parameters. Recipes can also be used to set and monitor PLC control 

parameters. 

In order to save the information required in the production process, you can read recipes from the PLC, 

write data to it, load recipes from files, or save recipes as files. These interactions can be achieved through 

the view elements that have been set up. 

Step 1 Right-click Application in the device tree, and select Add Object > Recipe Manager to add a recipe 

manager. 
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Step 2 After adding a recipe manager, you need to set the manager name. Click Open to show the 

configuration interface of the recipe manager in the figure below. 

 

Storage Type: You can select Textual or Binary storage type. 

File Path: You can specify the storage location through the file path, or define the file extension for storing 

the recipe; the storage of text will be separated according to the selected separator, and the separator is 

only effective when the Textual storage type is enabled.  

Available Columns: The right side contains the columns defined for the current recipe, i.e. Selected 

Columns, and the content of the selected columns will be stored. You can click the icon button  or  

to shift between Available Columns and Selected Columns. You can also shift all entries from one side to 

the other at once by clicking the icon button  or . The icon buttons  and  can be used to 

adjust the order of the selected columns, which represents the order of the columns in the storage file. 

Step 3 After the Configuration page is set up, right-click Recipe Manager in the device tree and select Add 

Object > Recipe Definition… to add a new recipe definition. 
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Step 4 Set the name of the new recipe and click Open to show the added recipe in the figure below. You can 

right-click a blank area and select Add a New Recipe to configure different recipe values. You can 

also select a recipe value (such as recipe 1) and right-click it to delete, load, or save the recipe. 

 

In addition to editing recipe files directly on the interface, you can also add “Recipe Management” library 

files and use code to create, delete, load, and save recipes. 

 

 



INVT Medium and Large-scale PLC Software Manual  Basic Functions 

202409 (V1.0)  49 

Step 5 After adding a recipe, you need to define the variables that the recipe needs to use in the program, 

and then insert the variables into the recipe and click . 

 

 

After the variables are inserted, you can fill in the parameters in Recipe 1 and Recipe 2. 

 

 

After login online, you can click Write Recipe to write the currently selected recipe value to the controller, or 

click Read Recipe to read the current value from the controller into the recipe. 
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3.11 Symbol Configuration 

The symbol configuration feature is used to configure project variables as symbols that require special 

access. With these symbols, variables can be accessed by external applications, such as an OPC server. If you 

select Generate Code in the Compile menu bar, a symbol configuration file (with the suffix *.xml in the 

project directory) is generated. The naming method is as follows: device name + application name.xml, 

which contains the description of the symbol. For example, import the XML into the HMI for label 

communication and access to variables. 

Right-click Application in the device tree, and select Add Object > Symbol Configuration. 
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After selecting symbol configuration, a pop-up window appears as shown below. 

 

Table 3-6 Description of Symbol Configuration 

Option Description 

Include comments in XML The exported XML contains comments assigned to variables 

Support OPC UA features The symbol variables can be accessed by OPC UA 

Compatibility layout 

The offset size is consistent with the type member definition. If the 

type member does not fully support symbol access, the offset size is 

the actual compilation offset, and there will be a blank in the middle 

Optimized layout 

The offset is calculated based on the selected type member, and no 

offset calculation will be performed if the type member is not 

selected. 
 

 Symbol configuration–Settings 

After generation, the Symbol Configuration Settings interface is as shown in the figure below. 
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The configuration comments and attributes are as shown in the figure below. The upper left side shows the 

data downloaded to the PLC, and the upper right side shows the exported XML data format. 

 

 

Table 3-7 Description of Symbol Configuration Comments and Attributes 

Option Description 

Symbol 
Generally, symbols represent variables, and symbol attributes 

represent variable characteristics (Attribute information). 

Comment format It indicates the comment download or display format. 

Attribute matching 
It indicates which attribute information is included when the XML file is 

exported or downloaded to the PLC. 
 

Symbol: Generally, symbols represent variables, and symbol attributes represent variable characteristics 

(Attribute information).  

Comment format: It indicates the comment download or display format.  

Attribute matching: It indicates which attribute information is included when the XML file is exported or 

downloaded to PLC. 

Four matching rules: Include all attributes, Match simple identifiers, Include attributes starting with:, and 

Filter Attributes with regular expression. 

Configure synchronization with IEC tasks: In the Device Properties options, select whether to synchronize 

with IEC tasks when other interfaces access symbol variables. Access cannot be made during IEC execution 

to prevent variables from being out of sync. 
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 Symbol Configuration–Tools 

You can use it to save the file in XML format to export an XML data model, which can be used as a reference if 

a third party parses symbols offline 

 

 

 Symbol Configuration Process Example 

Create new global variables bLatch and iMasterYout, and apply at least one of them in the user program, as 

shown in the figure below. 

 

Note: If any variable in a single global variable list is not used in the user program, the corresponding 

variable list will not appear in symbol configuration. 
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The steps to configure the sample are as follows: 

Step 1 After adding Symbol Configuration in Application, check Include comments in XML, and click 

Build > Build in the upper Toolbar. At this time, the corresponding variable list and variables appear 

in the right symbol configuration. Check the variable list to be configured, configure the 

corresponding access rights (read-only, write-only, read/write), and select Build > Generate code in 

the upper Toolbar. 

 

 

Step 2 You can find the generated file with the suffix .xml in the directory folder where the project is located, 

which is imported into the touch screen for label communication, as shown in the figure below. 

 

Step 3 After completing the above steps on the PLC, taking VS-102QS touch screen as an example, open the 

HMITOOL software, click New Project, Select “VS-102QS” as the Model, “Ethernet Port” as the 

Connection Port, and “CodeSys” and “CodeSys TCP V3 Communication Optimum” as the 

Connectivity Service, as shown in the figure below. 
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Step 4 Click Import Communication Labels, select the XML label just generated, and click Open. If 

Imported successfully is displayed, click OK, as shown in the figure below. 
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Step 5 Set the IP address of communication parameters to “192.168.1.10” and Port number to “11740”, 

and then click OK, as shown in the figure below. 

 

 

Step 6 Select Input Box in the figure above, and bind the corresponding PLC address, as shown in the 

figure below. After completion, label communication can be implemented. 

 

 



INVT Medium and Large-scale PLC Software Manual  Basic Functions 

202409 (V1.0)  57 

3.12 Task Configuration 

Each PLC application (project) contains “Task Configuration” in the project directory tree. In Task 

Configuration, one or more tasks can be defined to control and execute the application in the controller. 

After a “task” is configured, a series of programs or function blocks can be executed cyclically or triggered by 

a specific event to start executing the program. A task can call one or more program blocks (POUs). By 

setting priorities and conditions for tasks, you can define the order in which the tasks are processed. You can 

also configure a watchdog for each task, and the controller will prompt an exception when the execution 

cycle of the task is too long. 

3.12.1 Adding a Task 

After creating a new project, Invtmatic Studio will automatically add Task Configuration, the automatically 

generated tasks are shown in the figure below. 

 

 

If you need to add a new task, you can right-click Task Configuration and select Add Object > Task. After 

entering a custom task name in the pop-up window, click Open to add the task, as shown in the figure 

below. 



INVT Medium and Large-scale PLC Software Manual  Basic Functions 

202409 (V1.0)  58 
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3.12.2 Task Settings 

After opening the newly created task, the Settings interface shown in the figure below appears. 

 

 Priority: 0–31. The larger the value, the lower the priority, and 0 indicates the highest priority.  

 Type: Task type and its execution logic. See the table below for details. 

Table 3-8 Task Type 

Type Execution Logic Variable 

Cyclic 
The task is executed cyclically according to the 

set interval 
Time interval 

Event 

The task starts execution at the rising edge of 

the set global variable associated to the trigger 

event 

Trigger variable 

Freewheeling 

The task automatically starts execution at the 

beginning of the program and at the end of the 

complete process in a continuous cycle 

- 

State 
When the set global variable is TRUE, the task 

starts execution 
Trigger variable 

 

 Watchdog: If a task exceeds the currently set time of the watchdog, the task will be suspended in an 

error state (exception). The application in which the task with the error occurs and its child applications 

will also be suspended. All tasks of the affected application will also be stopped. The watchdog-related 

functions are detailed in the table below. 

Table 3-9 Watchdog Functions 

Option Function 

Enable It is used to enable the watchdog function 

Time It is used to set the watchdog timeout period 

Sensitivity 
It is used to set the value, that is, trigger the watchdog after exceeding the 

set time by several times 
 

 POU call: You can set the POU called by the task, and the order of POU calls will be affected. 
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3.12.3 TP6000 Multi-core Task Configuration 

The TP6000 series PLC supports dual-core configuration. In the Task Configuration interface, there are 2 task 

groups by default. You can add task groups as needed, which can be assigned to use Core 0 or Core 1. You 

can assign a priority to each task. Generally, it is required that the EtherCAT_Group containing 

EtherCAT_Task be configured as Core 1 for better real-time performance. 
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4 Hardware Configuration 

4.1 High-speed I/O Configuration 

For the TM700 series PLC, double-click TM75x-HSIO in the device window. Then, the HSIO parameter 

configuration interface will pop up. You can configure high-speed I/O functions and associated parameters 

on this interface, including high-speed counter, high-speed output, and high-speed input edge interrupt. 

Note: 

1. If Counter is not checked, it can be used as a normal input port. 

2. To use the counter function, check Counter 0 (1, 2, 3). Then, the corresponding input port is used as 

the input signal source of the counter. X0 and X1 are the input signal sources of counter 0 by default. 

The corresponding relationship between subsequent counters and high-speed input ports is similar. 

Once the counter function is enabled, a Counter device is generated and you can make detailed 

settings. 

Figure 4-1 High-speed I/O Port Configuration Interface 

 

 

4.1.1 Counter Interface Configuration 

You can set 5 functions for the input port: normal input, counter, trigger latch, Z signal, and pulse width 

measurement. The counter function module can count and calculate the input pulses, detect position, 

speed, frequency, etc. The maximum frequency of the input pulse is 200 kHz. 

You can double-click Counter under TM75x-HSIO to make detailed settings for the high-speed counter. 
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Figure 4-2 High-speed Counter Parameter Configuration 

 

 

 Counter mode: It indicates the counter mode, which can be selected from the following 6 options: 

phase A/B 1x, phase A/B 2x, phase A/B 4x, pulse+direction, single phase, and CW/CCW. If you choose to 

use phase A/B 1x/2x/4x, pulse+direction, or CW/CCW, X0 and X1 are the default input signal sources of 

counter 0, and the corresponding relationship between subsequent counters and high-speed input 

ports is similar. The signal source can also be set as needed; if single phase is selected, the input signal 

source of counter 0 can be selected from X0 to X7. 

 Input counting direction: positive or negative. 

 Counting mode: rotary or linear. 

 Max. number of pulses: 2147483647 by default, ranging from -2147483648 to 2147483647. 

Note: The upper limit value cannot be less than the lower limit value. If the set value is less than the lower 

limit value, the system will automatically change the lower limit value to be consistent with the upper limit 

value. 

 Min. number of pulses: -2147483648 by default, ranging from -2147483648 to 2147483647. 

 Preset input terminal: When the preset function is configured as external DI preset mode, this input 

port needs to be configured. You can select any input port from IN0 to IN7 to implement the preset 

value function, or you can set it as a software-triggered preset input. 

 Probe: Each counter can be configured with 2 probe input ports to realize the function of latching the 

counter value. Probe 1 is #1 probe input port and can be configured as any input port from IN0 to IN7. 

Probe 2 is #2 probe input port and can be configured as any input port from IN0 to IN7. 

 Output comparison terminal: When using the high-speed output comparison (single 

point/linear/queue) function, configure this output port in the range of OUT0–OUT7. 

 Hardware reset: When the count value reset function is configured as external DI mode, you need to 

configure this input port. You can select any input port from IN0 to IN7 to realize the count value 

clearing function. 
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4.1.2 Counter Functions 

For counter function control, for example in I/O mapping, you can set the counter clear and enable control 

bits. 

Figure 4-3 High-speed Counter Parameter Mapping 

 

 

Controlword/Reset is the counter reset control bit; while Controlword/Start is the counter enable control bit. 

Other functions can be configured as described in the table below. 

Table 4-1 Description of Counter Control Word and Status Word 

Parameter Name Type Description 

Controlword BYTE 

Counter control parameter. 

Bit0: Counter enabled, valid if TRUE 

Bit1: Counter cleared, valid at the rising 

edge 

Preset Value DINT Preset value of the counter. 

Preset command BYTE 

Preset function control. 

Bit0: Software preset enabled, valid at the 

rising edge 

Bit1: Preset reset 

Bit2: Preset done signal cleared 

Touch probe command1 BYTE 

Probe 1 function control word. 

Bit0: Probe start signal, valid is TRUE 

Bit1: Probe reset signal 

Bit2: Probe done cleared signal, valid is 

TRUE 

Touch probe command2 BYTE 

Probe 2 function control word. 

Bit0: Probe start signal, valid is TRUE 

Bit1: Probe reset signal 

Bit2: Probe done cleared signal, valid is 

TRUE 
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Parameter Name Type Description 

Compare command BYTE 

Comparison function control word. 

Bit0: Start 

Bit1: Enable 

Bit2: Reset 

Compare Value DINT Compare values. 

Compare Output Keep Value UINT 
Hardware output comparison result 

retention value. 

Compare Output Unit BYTE 
Output comparison retention unit. 

0: 100 μs, 1: pulse 

Statusword BYTE 

Counter status feedback. 

Bit0: Counter running status feedback (1: 

running) 

Bit1: Counter direction feedback (1: 

reverse) 

Bit2: Positive limit status feedback (1: 

reaching cntMax) 

Bit3: Negative limit status feedback (1: 

reaching cntMin) 

Bit4: Counter error status (1: error) 

Counter_Value DINT Counter value. 

Preset Status BYTE 

Preset status feedback. 

Bit0: Preset completed status feedback (1: 

done) 

Note: The preset done signal needs to be 

cleared, and the preset value cannot be 

modified before it is cleared. 

Touch Probe Status1 BYTE 

Counter probe 1 status feedback 

Bit0: Probe busy status feedback 

Bit1: Probe done status feedback 

Note: The preset done signal needs to be 

cleared, and the preset value cannot be 

modified before it is cleared. 

Touch Probe Status2 UDINT 

Counter probe 2 status feedback 

Bit0: Probe busy status feedback 

Bit1: Probe done status feedback 

Note: The preset done signal needs to be 

cleared, and the preset value cannot be 

modified before it is cleared. 

Latch rising pos1 DINT 
Probe 1 latches the rising edge acquisition 

position. 

Latch rising pos2 DINT 
Probe 2 latches the rising edge acquisition 

position. 

Latch falling pos1 DINT 
Probe 1 latches the falling edge acquisition 

position. 

Latch falling pos2 DINT 
Probe 2 latches the falling edge acquisition 

position. 

Compare Status BYTE 
Comparator status. 

Bit0: Output comparison busy status 
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Parameter Name Type Description 

feedback 

Bit1: Output comparison done status 

feedback 

Note: For counter preset control, the Preset command can use software operation to preset the counter 

value. After successfully presetting the counter value using PresetActiveSoft, you must use PresetDoneClean 

to clear the Preset Status before you can reset the counter value again. 

4.1.3 Description of Output Port Functions 

You can set 3 functions for the output port: normal output, high-speed pulse output, and output comparison. 

As shown in the figure below, the normal output port ranging from Y0 to Y7 is used by default. When the 

pulse output function is required, you need to check the pulse axis of the corresponding channel. 

Figure 4-4 High-speed Output Port Configuration 

 

4.1.4 Normal Output 

The normal output port ranging from Y0 to Y7 is used by default. 

The output port of the TM series PLC contains 8 output signals, Only single-ended outputs are supported, 

and the output signal is of the source type Y0–Y7 share the common port COM. 

Table 4-2 Description of the Normal Output Port of the TM700 Series PLC 

Schematic 

Diagram 
Left Signal Left Terminal 

Right 

Terminal 
Right Signal 

 

X0 input A0 B0 Y0 output 

X1 input A1 B1 Y1 output 

X2 input A2 B2 Y2 output 

X3 input A3 B3 Y3 output 

X4 input A4 B4 Y4 output 

X5 input A5 B5 Y5 output 

X6 input A6 B6 Y6 output 

X7 input A7 B7 Y7 output 

SS common input 

terminal 
A8 B8 

COM common output 

terminal 
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4.1.5 High-speed Pulse Output 

Once the pulse axis is checked, the signal port is configured as high-speed pulse output, and all 8 output 

ports can be configured as high-speed pulse outputs. 

High-speed pulse output supports four modes: pulse+direction, FWD/REV pulse, quadrature-encoded pulse, 

and PWM. 

Figure 4-5 High-speed Output Modes 

 

4.1.6 Output Comparison 

The output comparison function outputs the result of the counter single value comparison, and each 

counter channel has an output comparison function. If the counter value is equal to the set comparison 

value, a high output will be given; and if it is not equal, a low output will be given. 

 The output comparison port is configured in the corresponding counter channel 
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Figure 4-6 Output Comparison Configuration 

 

 Output Comparison Control 

Figure 4-7 Output Comparison Control Mapping 

 

4.1.7 Description of External Interrupt 

An interruption refers to the process in which the CPU suddenly stops the execution of task A to complete 

task B, and then comes back to continue executing task A. 

The steps to implement the external interrupt function are as follows: 
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Step 1 Set the input port for the interrupt function, select rising edge, falling edge, or rising/falling edge 

trigger, and set the filter parameter which is 0.5μs (2*0.25μs) by default. 

Figure 4-8 External Interrupt Input Configuration 

 

Step 2 Select an interrupt task 

In the Invtmatic Studio task, select External as the task type, select the event inxInterrupt of the input port 

X0–X7, where x ranges from 0 to 7, and trigger the corresponding POU_1 program by the interrupt task. 

Figure 4-9 Task Triggering by an External Interrupt 

 

4.2 Local I/O Expansion Module Configuration 

The PLC body can be directly expanded with Flex series modules, or connected to the FK1100 coupler via the 

EtherCAT bus to use expansion modules. A single TM700 series PLC or FK1100 coupler can be expanded with 

up to 32 Flex series modules (plus the power relay). The TP6000 series PLC body cannot be directly 

connected to the Flex series modules, but it can be connected to the FK1100 coupler via the EtherCAT bus 

and the expansion modules can be assembled to the coupler. For the models and functions of Flex series 

modules, see Table 4-3 for details. 

Table 4-3 Types of Expansion Modules 

Module Name Flex Series Module Description 

Coupler FK1100 EtherCAT bus adapter, expandable to 32 bus nodes 

Digital Input 

Module 

FL1001 16-channel digital input module, source/sink input 

FL1002 32-channel digital input module, source/sink input 

Digital Output 

Module 

FL2002 16-channel digital output module, source output 

FL2003 32-channel digital output module, source output 

FL2102 16-channel digital output module, sink output 
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Module Name Flex Series Module Description 

FL2103 32-channel digital output module, sink output 

FL2201 8-channel relay output 

Analog Input 

Module 

FL3003 4-channel analog input module, current/voltage 

input Temperature 

Module 

FL3103 4-way temperature module, thermal resistance type 

FL3203 4-way temperature module, thermocouple type 

Analog Output 

Module 

FL4003 4-channel analog output module, current/voltage 

output Hybrid input 

module 

FL5005 16-channel digital input + 16-channel digital output 

(source output) module FL5105 16-channel digital input + 16-channel digital output 

(sink output) module 
 

4.2.1 Expansion Module Configuration 

For TM700 series and TP6000 series PLCs, you can configure expansion modules through two methods: 

manual addition and automatic scanning. Automatic scanning takes precedence. 

Method 1: manual addition  

Open the Invtmatic Studio programming software, create a new project, select the programming language 

(for details, see chapter 2 Getting Started), and add the required extension modules. 

1. Add the FK1100 coupler module 

Step 1 Right-click Device in the left device tree, click EtherCAT_Master_SoftMotion to add it, right-click 

EtherCAT_Master_SoftMotion, select Add Device, and add the coupler to the device tree. 

Figure 4-10 Adding a Coupler Manually 
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Step 2 Select the FK100_ECT_Coupler in the device tree, click Add Device, select the required module in 

the Module Device column, and click Add Device to add it into the device tree. 

Figure 4-11 Adding an Expansion Module Manually 

 

 

2. Add modules to the controller (TM700 series PLC) 

Right-click Device in the device tree, choose Add Device, select the required module in the Dedicated 

Device bar, and click Add Device to add it into the device tree. 



INVT Medium and Large-scale PLC Software Manual  Hardware Configuration 

202409 (V1.0)  71 

Figure 4-12 Adding an Expansion Module to the PLC 
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Method 2: automatic scanning (recommended) 

1. Scan EtherCAT bus configuration 

Step 1 Open the Invtmatic Studio programming software, create a new project, and select the 

programming language. 

Step 2 Connect to the PLC and add EtherCAT master. For details, see chapter 2 Getting Started. 

Step 3 Right-click EtherCAT_Master_SoftMotion and select Scanned Devices. The connected device will 

be automatically displayed. Click Copy All devices to Project. 

Figure 4-13 Scanning Couplers and Expansion Modules 

 

Figure 4-14 Couplers and Expansion Modules Added after Scanning 

 

2. Scan local expansion modules 

Step 1 Open the Invtmatic Studio programming software, create a new project, and select the 

programming language. 

Step 2 Connect to the PLC and scan local expansion modules. You need to log in to the PLC, but you may 
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not start it. For details, see chapter 2 Getting Started. 

Step 3 Double-click Automatic Scanning and click Scan. The list shows the expansion modules connected 

to the device. Click Add to configuration. At this time, the configuration is completed. 

Figure 4-15 PLC Backplane Scanning 

 

 

4.2.2 Digital Input Module 

The digital input module is mainly used to configure filter parameters and has I/O Mapping, Status, and 

Information pages. Generally, you only need to map the I/O variables on the I/O Mapping page to obtain the 

digital input values. The 32-point digital input module is taken as an example in the figure below. 

 Filter parameters: 10 ms (1000*10 μs) by default. 

Figure 4-16 Input Module Configuration 
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 DI32 I/O mapping: You can get the input state through the BYTE or BOOL type. 

Figure 4-17 Variable Mapping of the Input Module 

 

4.2.3 Digital Output Module 

The digital output module is mainly used to set the output state selection after stopping and has I/O 

Mapping, Status, and Information pages. Generally, you only need to map the I/O variables on the I/O 

Mapping page to obtain the digital output values. The 16-point digital output module is taken as an example 

in the figure below. 
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Figure 4-18 Output Module Configuration 

 

DN16 I/O mapping: You can control the output state through the BYTE or BOOL type. 

Figure 4-19 Variable Mapping of the Output Module 

 

 

4.2.4 Analog Input Module 

 General Configuration 

The analog input module includes 4 channels, each of which has parameter configuration and I/O mapping 

register (16 bits) settings. Only one channel of each module is described below. 
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Figure 4-20 Analog Input Module Configuration 

 

 Channel enable: The channel can only be used after it is enabled. 

 Filter parameter: Analog input channel filter, ranging from 1 to 255. 

 Conversion mode: Set the analog input conversion type, which determines the channel input 

conversion type and the range of the conversion value. For details on the conversion type, see 

Table 4-4. 

 Disconnection detection: Set whether the analog input channel performs disconnection detection. 

Since it is impossible to distinguish between analog input 0 and disconnection, the disconnection 

flag cannot be activated in all conversion modes that include 0 value input. 

 Over-limit detection: Set whether the analog input channel performs over-limit detection. 

 Over-range detection: Set whether the analog input channel performs over-range detection. 

 Enhanced filtering: Set whether the analog input channel uses enhanced filtering. 

 4AD I/O Mapping 

4AD means 4-channel analog input. Each channel of analog input corresponds to a 16-bit integer value. For 

the relationship between analog value and digital value, see the general analog input configuration. You can 

map a variable to each 16-bit integer value on this interface to obtain the digital value corresponding to the 

analog value of an input channel. For details, see Table 4-4. 
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Figure 4-21 Variable Mapping of the Analog Input Module 

 

 

Figure 4-22 4AD Information Interface of the Analog Input Module 

 

Table 4-4 Correspondence between Mapped and Actually Input Analog Values 

Type Enter the Rated Range Rated Corresponding Digital Quantity 

Analog voltage input 

-10V–10V -20000–+20000 

0V–10V 0–20000 

-5V–+5V -20000–+20000 

0V–5V 0–20000 

Analog current input 

-20mA–20mA -20000–20000 

0mA–20mA 0–20000 

4mA–20mA 0–20000 
 

4.2.5 Analog Output Module 

 General Configuration 

The analog output module includes 4 channels, each of which has parameter configuration and I/O mapping 

register (16 bits) settings. Only one channel of each module is described below. 
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Figure 4-23 Variable Mapping of the Analog Output Module 

 

 

 Conversion mode: Set the analog output conversion type, which determines the channel output 

conversion type and the range of the conversion value. For details on the conversion type, see 

Table 4-5. 

 Keep output: After the module stops running, the output will keep the last output value. 

 Clear output: After the module stops running, the output is always 0. 

 Output preset value: After the module stops running, the output is always the preset value. The 

preset value range is related to the current conversion mode. See Table 4-5 for details. 

Table 4-5 Correspondence between Mapped and Actually Input Analog Values 

Type Enter the Rated Range Rated Corresponding Digital Quantity 

Analog voltage 

output 

-10–10 V -20000–+20000 

0–10 V 0–20000 
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Type Enter the Rated Range Rated Corresponding Digital Quantity 

-5–+5 V -20000–+20000 

0–5 V 0–20000 

Analog current 

output 

4–20 mA 0–20000 

0–20 mA 0–20000 

-20–20 mA -20000–+20000 
 

 4DA I/O Mapping 

4DA means a 4-channel analog output. Each channel of analog output corresponds to a 16-bit integer value. 

For the relationship between analog value and digital value, see Table 4-5. You can map a variable to each 

16-bit integer value on this interface to output the variable value to the current channel, and then convert it 

into an analog value output through the analog output module. 

Figure 4-24 Variable Mapping of the Analog Output Module 

 

 

 Information  

It displays the basic information of 4DA module devices: name, manufacturer, group, type, ID, version, 

model number, and description. In addition, after login, the Information interface will read and display the 

single-board software version (4DA embedded software version) and logic software version (FPGA software 

version in the 4DA module) of the 4DA module. 

Figure 4-25 4DA Information Interface of the Analog Output Module 
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4.2.6 Temperature Module 

The temperature module includes two types: 4TC (4-channel temperature detection module, supporting 

thermocouples) and 4PT (4-channel temperature detection module, supporting thermal resistors). 

4.2.6.1 4TC Temperature Module 

The 4TC temperature module (4-channel temperature detection module, supporting thermocouples) has 

corresponding general configuration and channel configuration. The general configuration is used to 

configure the unit type and sampling period of the temperature module, while the channel configuration is 

used to configure the sensor type, filter time, over-limit, temperature offset, and other parameters of each 

channel. 

 Channel Configuration 

Different types of modules support different channels, and 4TC supports 4 channels. Since the configuration 

parameters of each channel are basically the same, only one channel is described here. The configuration of 

a 4TC channel is shown in the figure below. 

Figure 4-26 4TC Temperature Module Configuration 

 

 

 Temperature unit: The unit used by the temperature module input, which supports Celsius or 

Fahrenheit. 

 Channel enable: The channel can only be used after it is enabled.  

 Sensor type: 4TC sensor type. See Table 4-6 for the sensor specifications. The K sensor is used by 

default. 

 Filter parameter: The filter used by this channel of the temperature module, ranging from 1 to 255, 

8 by default. 

 Over-range detection: When it is enabled, if the temperature is not between the upper and lower 

limits, an over-limit fault will be reported. For details, see Table 4-6. 

 Offset value (℃): It is used to set the temperature module offset compensation value, ranging from 

-204.8 to 204.7. 
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 I/O mapping 

Different types of temperature modules contain different numbers of channels and IO mappings. The figure 

below shows the I/O mapping interface of 4TC. The parameter value of each channel is the temperature 

value. 

Figure 4-27 Variable Mapping of the 4TC Temperature Module 

 

 

4.2.6.2 4PT Temperature Module 

The 4PT temperature module (4-channel temperature detection module, supporting thermal resistors) has 

corresponding general configuration and channel configuration. The general configuration is used to 

configure the unit type and sampling period of the temperature module, while the channel configuration is 

used to configure the sensor type, filter time, over-limit, temperature offset, and other parameters of each 

channel. 

 Channel configuration 

4PT supports 4 channels. Since the configuration parameters of each channel are basically the same, only 

one channel is described here. The configuration of one channel of 4PT is shown in the figure below. 

Figure 4-28 4PT Temperature Module Configuration 

 

 

 Temperature unit: The unit used by the temperature module input, which supports Celsius or 

Fahrenheit. 

 Channel enable: The channel can only be used after it is enabled.  
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 Thermal resistor wiring mode: 2-wire, 3-wire, or 4-wire. 

 Sensor type: 4PT sensor type. See Table 4-6 for the sensor specifications. The PT100 sensor is used 

by default. 

 Filter parameter: The filter used by this channel of the temperature module, ranging from 1 to 255, 

8 by default. 

 Over-range detection: When it is enabled, if the temperature is not between the upper and lower 

limits, an over-limit fault will be reported. For details, see Table 4-6. 

 Offset value ((℃): It is used to set the temperature module offset compensation value, ranging 

from -204.8 to 204.7. 

 I/O mapping 

Different types of temperature modules contain different numbers of channels and IO mappings. The figure 

below shows the I/O mapping interface of 4PT. The parameter value of each channel is the temperature 

value. 

Figure 4-29 Variable Mapping of the 4PT Temperature Module 

 

 Information 

Figure 4-30 Information Interface of the 4PT Temperature Module 

 

 



INVT Medium and Large-scale PLC Software Manual  Hardware Configuration 

202409 (V1.0)  83 

Table 4-6 Supported Sensor Types and Measurement Ranges 

Item Sensor Type 
Temperature Range in 

Celsius 

Temperature Range in 

Fahrenheit 

Thermal resistor 

type 

PT100 -200.0–850℃ -328.0–1562.0℉ 

PT500 -200.0–850℃ -328.0–1562.0℉ 

PT1000 -200.0–850℃ -328.0–1562.0℉ 

CU100 -50.0–150℃ -58.0–302.0℉ 

Thermocouple 

type 

B 200.0–1800℃ 392.0–3272.0℉ 

E -270.0–1000℃ -454.0–1832.0℉ 

N -200.0–1300℃ -328.0–2372.0℉ 

J -210.0–1200℃ -346.0–2192.0℉ 

K -270.0–1370℃ -454.0–2498.0℉ 

R -50.0–1765℃ -58.0–3209.0℉ 

S -50.0–1765℃ -58.0–3209.0℉ 

T -270.0–400℃ -454.0–752.0℉ 
 

4.3 Priority Setting for Each Module (Recommended Value) 

If the created project contains multiple functional modules, create multiple tasks and set the task priority as 

follows. For the recommended value of task priority, see Table 4-7. 

Figure 4-31 Example of Project Task Priority Setting 
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Table 4-7 Priority Setting 

Function Module Recommended Priority 

PlcCfg Module 31 

Modbus TCP 15–30 

Modbus RTU 15–30 

High-speed I/O (default configuration to 

MainTask) 
1 

Analog input/output 1–15 

Temperature Module 1–15 

EtherCAT 0 

 



INVT Medium and Large-scale PLC Software Manual  Network Configuration 

202409 (V1.0)  85 

5 Network Configuration 

The PLC network configuration mainly involves the following networks: Modbus TCP, Modbus RTU, 

EtherCAT, and CANopen. 

5.1 Modbus TCP  

5.1.1 Modbus TCP Master Configuration 

When the PLC is used as a Modbus TCP master, right-click Device in the left device tree, select Add Device, 

and then Dedicated Device > Modbus TCP Protocol > Modbus TCP Master 1 in the pop-up window, and 

click Add Device in the lower right corner. 

Figure 5-1 Adding a Modbus TCP Master 

   

 

Double-click the master device Modbus_TCP_Master 1 in the device tree to open the Modbus master 

configuration window, as shown in the figure below. The frame interval (ms) refers to the time interval 

between the master receiving the last response data frame and the next request data frame. This parameter 

can be used to adjust the data exchange rate. 



INVT Medium and Large-scale PLC Software Manual  Network Configuration 

202409 (V1.0)  86 

Table 5-2 Modbus TCP Master Settings 

 

The number of variables accessible by ModbusTCP is defined as follows: 

 Read coils (0x01): quantity of coils: 1–2000 (0x7D0) 

 Read discrete coils (0x02): quantity of coils: 1–2000 (0x7D0) 

 Read holding registers (0x03): quantity of registers: 1–125 (0x7D) 

 Read input registers (0x04): quantity of registers: 1–125 (0x7D) 

 Write single coil (0x05) 

 Write single register (0x06) 

 Write multiple coils (0x0F): quantity of coils 1–1968 (0x7B0) 

 Write multiple registers (0x10): quantity of registers: 1–123 (0x7B) 

Table 5-1 Definition of the Number of Variables Accessible by Modbus TCP 

Variable Qty. 

Read coils (0x01) 1–2000 (0x7D0) 

Read discrete coils (0x02) 1–2000 (0x7D0) 

Read holding registers (0x03) 1–125 (0x7D) 

Read input registers (0x04) 1–125 (0x7D) 

Write single coil (0x05) - 

Write single register (0x06) - 

Write multiple coils (0x0F) 1–1968 (0x7B0) 

Write multiple registers (0x10) 1–123 (0x7B) 
 

5.1.2 Modbus TCP Master Communication Configuration 

 Adding a Modbus TCP Slave 

Right-click Modbus_TCP_Master 1 in the left device tree, select Add Device, and then Modbus TCP Slave 1 

in the pop-up window, and click Add Device in the lower right corner. 
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Figure 5-3 Adding a Modbus TCP Slave 

   

 Setting the Modbus TCP Slave 

Figure 5-4 Setting the Modbus TCP Slave 

 

 

Table 5-2 Description of Modbus TCP Slave Parameter Settings 

Parameter Function 

IP address IP address for connecting the master to the Modbus TCP slave 

Port TCP port number for connecting the master to the Modbus TCP slave 
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Parameter Function 

Node number 
Protocol node number for connecting the master to the Modbus TCP 

slave 

Timeout period (ms) 
After the master sends a frame, if the slave does not respond within the 

time period, the master reports a receive timeout. 

Slave enable 
After programming and enabling this variable, the master starts to send 

communication frames to the slave. 

 

 Modbus TCP master to Modbus TCP slave communication settings 

Each channel represents an independent Modbus TCP request, as shown in the figure below. The third line 

defines an operation of writing a single register (function code 0x06) at a cycle of 10 ms, i.e. writing 2 bytes of 

data to the register with an offset address of (0x0014)20 (1 register occupies 2 bytes). 

Figure 5-5 Modbus TCP Master to Modbus TCP Slave Communication Settings 

 

 Add: Click Add to open the dialog box for adding a new channel for the Modbus TCP slave, and then 

click OK to create a new channel. 

 Edit: Select a channel in the Modbus TCP slave channel list and click Edit to open the dialog box for 

changing the channel configuration by modifying the parameters in it, and then click OK to update 

channel settings. 

 Export to EXCEL: Click Export EXCEL to export channel parameters to an EXCEL table in batches, and 

then click Import to import channel parameters into the settings in batches. 
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When adding or editing a channel, you will see the following pop-up dialog box: 

Figure 5-6 Dialog Box for Modbus TCP Master to Modbus TCP Slave Communication Settings 

 

Table 5-3 Description of Modbus TCP Communication Parameter Settings 

Parameter Description 

Name A string that names the channel 

Function code 

Read coils (function code 0x01) 

Read input coils (function code 0x02) 

Read holding registers (function code 0x03) 

Read input registers (function code 0x04) 

Write single coil (function code 0x05) 

Write single register (function code 0x06) 

Write multiple coils (function code 0x15) 

Write multiple registers (function code 0x16) 

Enable type 

Cyclic: requests triggered cyclically 

Cycle time: time for execution again 

Level trigger: triggered when programming changes 

Trigger variable (SM): SM element triggered (after enabling, the trigger 

variable is set after the communication is completed) 

Retry times 
If a communication failure occurs and no slave return frame is obtained, 

resending is performed according to the retry times. 

Comment A short text area that describes the data 

Read 

register 

Starting 

address 
The starting position of the register read 

Length Number of registers read 

Error 

processing 

Keep the last value: Keep the data at the last valid value 

Set to 0: Set all values to zero 

Write 

register 

Starting 

address 
The starting position of the register written 

Length The length of the register written 
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 Internal I/O Mapping of Modbus TCP Slave 

After adding the master-slave communication configuration to the Modbus TCP slave communication 

settings, the mapping address of each configuration will be automatically assigned in the internal I/O 

mapping. For example, %IW98 in the third line of the figure below means that the read coil value is mapped 

to the address %IW98. In addition, you can also map custom variables in the program to I/O addresses by 

using the Input Assistant or by directly entering the example variable path. 

Figure 5-7 Internal I/O Mapping for Modbus TCP Master Connection to Slave 

 

5.1.3 Modbus TCP Slave Configuration 

When the PLC is used as a Modbus TCP slave, right-click Device in the left device tree, select Add Device, 

and then Dedicated Device > Modbus TCP Slave Device1 in the pop-up window, and then click Add Device 

in the lower right corner. 

Figure 5-8 Adding a Modbus TCP Slave 

 

Double-click the slave device in the device tree to open the Modbus TCP slave configuration window, as 

shown in the figure below. 
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Figure 5-9 Modbus TCP Slave Settings 

 

Table 5-4 Modbus TCP Slave Parameter Settings 

Parameter Function 

Port TCP port number of the Modbus TCP slave 

Frame interval 

(ms) 

The delay time for the Modbus TCP slave to send a response frame after 

receiving a communication frame 

Node number The number to identify the node 

 

The Modbus_TCP_Slave defines storage areas accessible by external devices, which are shown in the 

following table. 

Table 5-5 Modbus_TCP_Slave Function Codes 

TCP Master 

Function Code 
Address name Range 

Offset from Standard 

Modbus Address 

0x01 %QX 0–65535 None 

0x05/0x15 %QX 0–65535 None 

0x02 %IX 0–65535 None 

0x04 %IW 0–65535 None 

0x03 %MW 0–65535 None 

0x06/0x16 %MW 0–65535 None 
 

Table 5-6 Example of Correspondence between Controller Bit, Byte, Word, and Double Word 

%_X 195.7–195.0 194.7–194.0 193.7–193.0 192.7–192.0 

%_B 195 (8 MSBs) 194 (8 LSBs) 193 (8 MSBs) 192 (8 LSBs) 

%_W 97 (16 MSBs) 96 (16 LSBs) 

%_D 48 

 

5.1.4 Modbus TCP Device Diagnosis 

The Modbus TCP master device diagnosis interface displays slaves and communication parameters with 

errors. 
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Figure 5-10 Modbus TCP Master Device Diagnosis Interface 

 

 

5.2 Modbus RTU 

The PLC supports two Modbus serial port communications, namely COM1_RS485 and COM2_RS485, both of 

which support the standard Modbus RTU protocol and can be independently configured as a master or slave 

station, supporting seven baud rates: 2400, 4800, 9600, 19200, 38400, 57600, and 115200. 

The number of variables accessible by Modbus RTU is defined as follows: 

 Read coils (0x01), number of coils 1–2000 (0x7D0) 

 Read discrete coils (0x02), number of coils 1–2000 (0x7D0) 

 Read holding registers (0x03), number of registers 1–125 (0x7D) 

 Read input register (0x04), number of registers 1–125 (0x7D) 

 Write single coil (0x05) 

 Write single register (0x06) 

 Write multiple coils (0x0F): quantity of coils 1–1968 (0x7B0) 

 Write multiple registers (0x10): quantity of registers: 1–123 (0x7B) 

Table 5-7 Definition of the Number of Variables Accessible by Modbus RTU 

Variable Qty. 

Read coils (0x01) 1–2000 (0x7D0) 

Read discrete coils (0x02) 1–2000 (0x7D0) 

Read holding registers (0x03) 1–125 (0x7D) 

Read input registers (0x04) 1–125 (0x7D) 

Write single coil (0x05) - 

Write single register (0x06) - 

Write multiple coils (0x0F) 1–1968 (0x7B0) 

Write multiple registers (0x10) 1–123 (0x7B) 
 

5.2.1 Modbus RTU Master Configuration 

When the PLC is used as a Modbus RTU master, right-click Device in the left device tree, select Add Device, 

and then Dedicated Device > Modbus RTU Protocol > Modbus Master 1 in the pop-up window, and click 

Add Device in the lower right corner. 
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Figure 5-11 Adding a Modbus RTU Master 

  

 

Open the Modbus master configuration window, as shown in the figure below. 

Note: Normal communication is possible only when the Modbus master and slave communication 

parameters are consistent. 

Figure 5-12 Modbus Master Settings 

 

Table 5-8 Description of Modbus Master Parameter Settings 

Parameter Description 

Baud rate Communication rate: 2400, 4800, 9600, 19200, 38400, 57600, 115200 

Check bit Communication frame check mode: None Parity, Odd Parity, Even Parity 

Data bit The actual data bits contained in the communication frame 

Stop bit Identify the last bit of a single packet during communication 

Frame interval 

(ms) 

The time interval between the master receiving the last response data frame 

and the next request data frame 
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5.2.2 Modbus RTU Master Communication Configuration 

 Adding a Modbus Slave 

When the PLC is used as a Modbus master, right-click Modbus Master 1 in the left device tree, select Add 

Device, and then Dedicated Device > Modbus RTU Protocol > Modbus RTU Slave1 in the pop-up window, 

and click Add Device in the lower right corner. 

Figure 5-13 Adding a Modbus RTU Slave When the Port Is Used as a Master 

  

 Setting the Modbus Slave 

Double-click the slave device in the device tree to open the Modbus slave configuration window as shown in 

the figure below. 

Figure 5-14 Modbus RTU Slave Settings When the Port Is Used as a Master 

 

 

Table 5-9 Description of Modbus RTU Slave Parameter Settings When the Port Is Used as a Master 

Variable Function 

Node number The number to identify the salve, ranging from 1 to 247 
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Variable Function 

Timeout period (ms) 
After the master sends a frame, if the slave does not respond within the 

time period, the master reports a receive timeout. 

Slave enable (SM) 
After programming and enabling this variable, the master starts to send 

communication frames to the slave. 

 

 Modbus master to Modbus slave communication settings 

Switch to the Modbus slave communication settings window and add a Modbus slave communication 

configuration. The configuration table supports up to 60 configurations. 

Each channel represents an independent Modbus request, where the first line defines a request to execute 

the action of writing a single register cyclically (function code 0x06), i.e. writing one word of data to a 

register at an offset of 0x2000. 

Figure 5-15 Modbus Slave Communication Settings When the Port Is Used as a Master 

 

 Add: Click Add to open the dialog box for adding a new channel for the Modbus slave. Click OK to 

create a new channel. 

 Edit: Select a channel in the Modbus slave channel list and click Edit to open the dialog box for 

changing the channel configuration by modifying the parameters in it, and then click OK to update 

channel settings. 

 Export to EXCEL: Click Export to EXCEL to export channel parameters to an EXCEL table in batches, 

and then click Import to import channel parameters into the settings in batches. 
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When adding or editing a channel, you will see the following pop-up dialog box: 

Figure 5-16 Dialog Box for Modbus Slave Communication Settings When the Port Is Used as a Master 

 

Table 5-10 Description of Modbus Communication Parameter Settings 

Parameter Description 

Name A string that names the channel 

Function code 

Read coils (function code 0x01) 

Read input coils (function code 0x02) 

Read holding registers (function code 0x03) 

Read input registers (function code 0x04) 

Write single coil (function code 0x05) 

Write single register (function code 0x06) 

Write multiple coils (function code 0x15) 

Write multiple registers (function code 0x16) 

Enable type 

Cyclic: requests triggered cyclically 

Cycle time: time for execution again 

Level trigger: triggered when programming changes 

Trigger variable (SM): SM element triggered. After triggered successfully, the 

element will be automatically reset. 

Retry times 
If a communication failure occurs and no slave return frame is obtained, 

resending is performed according to the retry times. 

Comment A short text area that describes the data 

Read 

register 

Starting 

address 
The starting position of the register read 

Length Number of registers read 

Error 

processing 

Keep the last value: Keep the data at the last valid value 

Set to 0: Set all values to zero 

Write 

register 

Starting 

address 
The starting position of the register written 

Length The length of the register written 
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 Internal I/O Mapping of Modbus Slave 

After adding the master-slave communication configuration to the Modbus slave communication settings, 

the mapping address of each configuration will be automatically assigned in the internal I/O mapping. For 

example, %QW1 in the first line of the figure below means that the read coil value is mapped to the 

address %QW1. In addition, you can also map custom variables in the program to I/O addresses by using the 

Input Assistant or by directly entering the example variable path. 

Figure 5-17 Internal I/O Mapping of Modbus Slave When the Port Is Used as a Master 

 

5.2.3 Modbus RTU Slave Configuration 

When the PLC is used as a Modbus slave, right-click Device in the left device tree, select Add Device, and 

then Dedicated Device > Modbus RTU Protocol > Modbus RTU Slave Device1 in the pop-up window, and 

click Add Device in the lower right corner. 

Double-click the slave device in the device tree to open the Modbus slave configuration window as shown in 

the figure below. 

In the Modbus slave parameter settings, the serial port configuration has the same meaning as that of the 

Modbus master. The node number in the Modbus slave configuration refers to the node number of this 

device; the frame interval refers to the delay time for response to the master after receiving the 

communication frame sent by the master. 

Figure 5-18 Configuration When Modbus RTU Is Used as a Slave 

 

Note: Normal communication is possible only when the Modbus master and slave communication 

parameters are consistent. 

The Modbus_RTU_Slave defines storage areas accessible by external devices, which are shown in the 

following table. 
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Table 5-11 Modbus_RTU_Slave Function Codes 

RTU Master 

Function Code 
Address name Range 

Offset from Standard 

Modbus Address 

0x01 %QX 

0–65535 None 

0x05/0x15 %QX 

0x02 %IX 

0x04 %IW 

0x03 %MW 

0x06/0x16 %MW 
 

5.2.4 Modbus RTU Device Diagnosis 

The Modbus master device diagnosis interface displays slaves and communication parameters with errors. 

Figure 5-19 Modbus Master Device Diagnosis 

 

 
 

5.2.5 Common Faults of Modbus RTU 

The main faults that occur when the Modbus master is connected to the slave are as follows: 

 The configurations of the Modbus master and slave are inconsistent, resulting in the inability to 

establish communication between the master and the slave. 

 The Modbus master accesses an illegal address of the Modbus slave and an error response is returned. 

 The Modbus master operates the Modbus slave to write a register, but the Modbus slave only supports 

read actions on this register. The Modbus master will receive an error response returned by the Modbus 

slave. 

Error response frame format: slave address + (instruction code + 0x80) + error code + CRC check. 

Note: This error frame applies to all operation instruction frames.  

Table 5-12 Description of Modbus Error Response Frames 

Number Data (Byte) Meaning Number of Bytes Description 

1 Slave address 1 byte Value range: 1–247 

2 Instruction code + 0x80 1 byte Error instruction code 

3 Error code 1 byte 1–4 
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5.3 EtherCAT Master 

EtherCAT (Ethernet for Control Automation Technology) is an open-architecture, Ethernet-based fieldbus 

system. Compared with other fieldbuses, EtherCAT has the characteristics of good performance, high device 

synchronization accuracy, flexible topology, easy application, and low cost. Currently, more and more 

devices use the EtherCAT bus for communication. 

5.3.1 EtherCAT Master Configuration 

5.3.1.1 Adding a Device Profile 

INVT EtherCAT slave devices have been pre-added in Invtmatic Studio. If you use an INVT product, you can 

skip this step directly. When using an EtherCAT slave without a device profile added to the software, you 

need to add the corresponding profile to the software. The operation steps are as follows: 

Step 1 Open Invtmatic Studio and select Tools > Device Repository in the Toolbar. 

Figure 5-20 Selecting a Device Repository 

 

Step 2 In the pop-up window, click Install. 

Figure 5-21 Installing the Device Repository 
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Step 3 In the pop-up window, find the path where the device profile is stored. 

Note: Here, select EtherCAT XML device profile as the file type. If you select other file types, you will not be 

able to select the XML file normally. After finding the corresponding XML, click Open. 

Figure 5-22 Selecting Device Profile Path and Type 

 

 

Step 4 After opening the file, the software will automatically import the device. At this time, you can 

observe the information output box and confirm that the installation is complete. Then, Click Close. 

Figure 5-23 Importing the Device Profile into the Device 

 

 



INVT Medium and Large-scale PLC Software Manual  Network Configuration 

202409 (V1.0)  101 

5.3.1.2 Slave Configuration 

In the Invtmatic Studio software, you can configure the EtherCAT slave through two methods: automatic 

scanning and manual addition. For detailed operation steps, see section 2.3 Examples of Program Writing 

and Debugging. When adding an EtherCAT slave by automatic scanning, you must first ensure that the slave 

device hardware used in the project is correctly connected to the PLC. Only when normal communication is 

possible can the PLC scan the EtherCAT slave device. 

5.3.1.3 Master Settings 

You can set the EtherCAT master parameters on the EtherCAT Master Settings interface. As shown in Figure 

5-24, you need to set the cycle and synchronization offset of the distributed clock. 

 Cycle: The interval for sending EtherCAT data frames, which must be the same as the cycle time of the 

EtherCAT task. 

 Synchronization offset: The percentage of the relative offset of the EtherCAT task relative to the Sync0 

interrupt of the slave, which is 20% by default, and cannot be modified generally. 

Figure 5-24 Setting Master Cycle and Synchronization Offset 
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In the DC mode of EtherCAT communication, after parsing the data transmitted by the master, the slave also 

needs to process the data in the DC interrupt. Since the time it takes for the master to transmit data to each 

slave varies, in order to ensure data synchronization, there must be enough time between the data frame 

and the synchronization interrupt for the slave to receive and process the data. This period of time is the 

offset time. 

Note: When using it, you need to add the master name. For example, if the master name is 

EtherCAT_Master_SoftMotion, then when restarting the master, the variable that needs to be triggered is 

EtherCAT_Master_SoftMotion.xRestart. Common parameters of the EtherCAT master are listed in Table 

5-13. 

Table 5-13 Common Parameters of EtherCAT Master 

Variable Name Function 

xRestart 
Rising edge trigger, restarted after being 

triggered 

EtherCAT Master 

xConfigFinished Master configuration completed 

xDistributedClockInSync EtherCAT distributed clock synchronization 

xError Error in the EtherCAT master 
 

5.3.2 EtherCAT Slave Configuration 

5.3.2.1 General Settings 

 EtherCAT address 

The configuration address of the EtherCAT slave refers to the sequential address of the slave device in the 

Invtmatic Studio device tree, starting from 1001 and increasing in sequence, as shown in Figure 5-25. You 

can find the EtherCAT address of the slave on the Slave Settings interface. This address will be used when 

the SDO read/write function block is called, as shown in Figure 5-26. 

Figure 5-25 EtherCAT Slave Address 
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Figure 5-26 SDO Read Function Block 

 

 

 Distributed clock 

This option is used to set the synchronous running mode of the slave. There are three synchronization 

modes: freewheeling (FreeRun), synchronization with an input/output event (SM-Synchron), and 

synchronization with a distributed clock (DC-Synchron). 

The options supported by the synchronization mode will vary with the selected slave. Generally, you do not 

need to modify this option, as long as the synchronization unit cycle in DC-Synchron mode is consistent with 

the EtherCAT task cycle, as shown in the figure below. 

Figure 5-27 Distributed Clock Parameters 

 

 Node alias 

When EtherCAT addresses are used, if the actual device connection order is inconsistent with the 

configuration order, the bus will not operate normally. If you hope that the actual slave connection order 
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will not be affected by the configuration order, you can use the alias function to rename the servo. During 

the connection process, the servo is no longer identified by the automatically assigned node address, but by 

the name. To use the node alias function correctly, you need to set the node alias of the slave first. The 

operation steps are as follows: 

Step 1 Set the alias address after scanning the relevant device. 

Figure 5-28 Setting a Node Alias 

 
 

Step 2 After the assignment is completed, Power off and restart the servo to activate it. Perform scanning 

again. At this time, the alias address has been written. 

Figure 5-29 Restart to Activate the Node Alias 

 
 

Step 3 Double-click the EtherCAT slave device INVT_DA200_265 in the device tree, check Enable Expert 

Settings and select Configured Node Alias in the Identification options, and fill in the correct alias 

address, as shown in the figure below. Then, restart the controller. 
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Figure 5-30 Filling in the Node Alias 

 
 

5.3.2.2 Process Data Object (PDO) 

After the slave enables expert settings, an expert process data interface will be added. The interface will 

display the input and output PDOs that come with the slave profile. You can add and delete them as needed, 

such asFigure 5-31 Output PDO (usually control word and given parameters), such as the Input PDO in Figure 

5-32 (usually status word and feedback parameters). In the EtherCAT I/O mapping interface, you can map 

the corresponding variables and call them in the program, as shown in Figure 5-33. 

Figure 5-31 Output PDO 
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Figure 5-32 Input PDO 

 

 

Figure 5-33 EtherCAT I/O Mapping 

 

5.3.2.3 Startup Parameters 

Some startup parameters can be written to the slave by the SDO write function when the slave is in the 

PreOP state, as shown in the figure below. 

Figure 5-34 Startup Parameters 

 

In actual use, you can add startup parameters as needed. Taking DA200 servo drive as an example, if you 

need to change the homing method to 35 at startup, follow the steps blow: 
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Step 1 Click Add on the Startup Parameters interface, as shown in Figure 5-34. 

Step 2 In the pop-up window, find the object dictionary 16#6098, namely the homing method, as shown in 

Figure 5-35, set the value to 35, and then click OK. 

Figure 5-35 Selection of the Homing Method 

 

 

Step 3 Once added, the corresponding item will be displayed in the list, indicating that the startup 

parameter has been added successfully, as shown in Figure 5-34. 

5.3.2.4 CiA 402 Axis 

When using the motion control function in Invtmatic Studio, you need to first add a 402 axis under the 

EtherCAT slave, which will be used as the control object in the program. For details on the corresponding 

parameter configuration of the EtherCAT master, see section 5.3.1 EtherCAT Master Configuration. Here, the 

EtherCAT master connected to DA200 servo drive slave is taken as an example, which is for reference only. 

If you use a slave from INVT, Invtmatic Studio has already pre-processed it and will automatically add the 

corresponding axis when you add the slave. If you use a third-party slave, you need to manually add the 402 

axis when using it, and add the library file “INVT_DA200_xxx.devdesc.xml” required by this module. Taking 

INVT_DA200_265 as an example, the operation steps are as follows: 

Note: 

 The highest task priority 0 is recommended for the creation of EtherCAT Master SoftMotion projects. 

 It is recommended to keep the synchronization cycle and the task cycle consistent and set them ≥ 4 ms. 

 To create EtherCAT Master SoftMotion, it is recommended to use separate tasks. For example, tasks 

such as I/O, analog input and output, and Modbus communication need to be separated from EtherCAT 

Master SoftMotion tasks. 

Step 1 Right-click Device in the device tree, select Add Device and then Fieldbus > EtherCAT > Maser > 

EtherCAT Master SoftMotion. 
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Figure 5-36 Process of Adding the EtherCAT Motion Control Master 

 

 

Step 2 Right-click EtherCAT_Master_SoftMotion and select Add Device to add the INVT DA200 servo drive. 

The operation steps are shown in the figure below. 

Figure 5-37 Adding DA200 Servo Drive 

 

Step 3 Select INVT_DA200_265 in the device tree, right-click and add SoftMotion CiA 402 Axis, and add the 

calling program, as shown in the figure below. 
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Figure 5-38 DA200 Servo Drive Application Example 

 

5.3.2.5 Common Parameters of EtherCAT Slave 

Common parameters of the EtherCAT slave are listed in Table 5-14. When using it, you need to add the slave 

name. For example, if the slave name is INVT_DA200_265, when the slave state is read, the corresponding 

variable is INVT_DA200_265.wState. 

Table 5-14 Common Parameters of EtherCAT Slave 

Variable Name Function 

wState 

1: ETC_SLAVE_INIT 

2: ETC_SLAVE_PREOPERATIONAL 

3: ETC_SLAVE_BOOT 

4: ETC_SLAVE_SAVEOPERATIONAL 

8: ETC_SLAVE_OPERATIONAL 

SlaveAddr Slave address 
 

5.3.2.6 Enabling/Disabling a Slave 

In actual applications, you may encounter situations where the configuration is inconsistent with the actual 

hardware connection, resulting in the inability of the bus to operate normally. In view of this situation, 

Invtmatic Studio provides a solution that allows users to disable unconnected slaves to ensure that the bus 

can operate normally. When variables associated to a device are used in the program, disabling the device 

will prevent compilation errors. 
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Figure 5-39 Disabling a Device 

 

 

Note: 

 Disabled devices in the device tree are displayed in light gray color, as shown in the figure below. 

Figure 5-40 Device Disabled State 

 

 

 When you log in to the system, the running states of disabled devices will not be displayed, as shown in 

the figure below. 
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Figure 5-41 Program Running While Disabled Devices Inactive 

 

 

 When you need to re-enable the device, click “Enable Device”, as shown in the figure below. 

Figure 5-42 Enabling a Device 

 

5.3.3 EtherCAT Redundancy Ring Network Function 

EtherCAT can use the cable redundancy technology to meet the rapidly growing system reliability 

requirements. This technology can ensure that devices can be replaced without shutting down the network. 

Adding redundancy is not expensive: Just add a standard Ethernet port (no dedicated network card or 

interface required) and a cable to the master device to transform the linear topology into a ring topology. 

When a device or cable fails, switching can be completed in just one cycle. Therefore, even for applications 

with motion control requirements, there will be no problems in the event of a cable failure. 

EtherCAT uses hot backup to support master redundancy. Once an outage, device failure, or other issues 

occur, the EtherCAT slave controller can automatically return Ethernet frames immediately, so the entire 

network will not be shut down. For example, the standard EtherCAT topology is shown in Figure 5-43 a). If 
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there is a network interruption between Slave 2 and Slave N-2 in this topology, as indicated by the red part 

in the figure, the communication of all slaves after Slave N-2 will also be interrupted accordingly, which is 

also a disadvantage of the standard topology. 

Figure 5-43 EtherCAT Redundancy 
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a) EtherCAT standard topology structure b) EtherCAT redundant topology structure
 

Figure 5-43 b) shows the topology of EtherCAT in redundancy mode. The master only needs two standard 

network ports to implement this topology. Using these two network ports, all slaves can form a loop. Even if 

the network is interrupted during use, as indicated by the red part in Figure 5-43, the master will 

immediately detect the error and automatically divide the communication into two paths, while the slaves 

can continue communication to ensure the stable operation of the system. 

Note: According to the EtherCAT protocol standard, the first slave is the standard clock, so the failure of 

the first slave will affect the communication of the entire bus. 

As shown in Figure 5-44, you can configure a redundancy ring network as follows: 

Double-click Slave EtherCAT_X3 to open it, and check Enable redundancy to show Redundancy EtherCAT 

NIC Setting parameters. For both EtherCAT NIC Setting and Redundancy EtherCAT NIC Setting, it is 

recommended to check Select network by MAC or Select Network by name. The latter one is used in 

Invtmatic Studio by default. Click Browse to confirm that the corresponding EtherCAT network interface is 

well configured, and then check Automatic restart slaves. 

Note: When the network cable between the first and second slaves is unplugged, the three slaves on the 

bus can still operate normally. 

Figure 5-44 EtherCAT Redundancy Ring Network Configuration 
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5.3.4 Dual EtherCAT Masters 

TP6214 supports dual EtherCAT masters. In Invtmatic Studio, when you select the device TP6214, you can 

add two EtherCAT masters and automatically assign EtherCAT network ports X3 and X2, as shown in Figure 

5-45. It is generally recommended to connect the servo and 402 axis with higher real-time performance to 

EtherCAT_X3, and couplers to EtherCAT_X2. 

Figure 5-45 Dual EtherCAT Master Connection Effect 

 

 

Note: For the dual-master task configuration, it is required to set the priority of EtherCAT_X3_Task to the 

highest 0, the priority of EtherCAT_X2_Task to 1, and the priority of other tasks to start from 2, as shown in 

the figure below. 

Figure 5-46 Dual-master Task Priority Configuration 
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5.4 CANopen 

CANopen is a high-level communication protocol that is based on the CAN (Controller Area Network) 

protocol, including communication profile and device profile. 

The communication model defines four types of messages (communication objects) 

1. Management message 

It mainly involves layer management, network management, and ID assignment services: such as 

initialization, configuration, and network management (including: node protection). The services conform 

to the LMT, NMT, and DBT services of the CAL, and uses the master-slave communication mode, which 

means there can only be one LMT, NMT, or DBT master node and one or more slave nodes in a CAN network. 

2. Service Data Object (SDO) 

By using indexes and sub-indexes (in the first few bytes of a CAN message), the SDO enables clients to access 

items (objects) in the device (server) object dictionary. 

SDO is implemented through a multi-domain CMS object in CAL that allows the transfer of data of any length 

(The data will be split into several messages when it exceeds 4 bytes). 

SDO communication has the service type defined: generating an answer for each message (two IDs are 

required for an SDO).SDO 

SDO request and answer messages always contain 8 bytes (meaningless data lengths are indicated in the 

first byte which carries the protocol information). 

3. Process Data Object (PDO) 

PDO is used to transfer real-time data from a creator to one or more recipients. Data transfer is limited to 1 

to 8 bytes (for example, one PDO can transfer up to 64 digital I/O values, or 4 16-bit AD values). 

PDO communication has no protocol defined. PDO data content is defined only by its CAN ID, assuming that 

the creator and recipients know the data content of the PDO.  

Each PDO is described by two objects in the object dictionary: 

A. PDO communication parameters determine which COB-ID will be used by the PDO, transmission 

type, prohibition time, and timer cycle. 

B. PDO mapping parameter: a list of objects in the object dictionary that are mapped to the PDO, 

including their data lengths (in bits). The creator and recipients must know this mapping to 

interpret PDO content. 

PDO message content is predefined (or configured at network startup). Mapping application objects to the 

PDO is described in the device object dictionary. If the device (creator and recipients) supports variable PDO 

mappings, the PDO mapping parameters can be configured using SDO messages. 

PDO can be delivered in the following modes: 

A. Synchronization (by receiving SYNC objects)  

Acyclic: The transmission is pre-triggered by a remote frame or by an object-specific event defined in 

the device profile.  

Cyclic: The transmission is triggered after every 1 to 240 SYNC messages.  

B. Asynchronization  

The transmission is triggered by a remote frame or  
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by an object-specific event defined in the device profile. 

4. Predefined messages or special function objects 

A. SYNC 

B. Time stamp 

C. Emergency 

D. Node guarding 

5.4.1 CANopen Master Node Configuration 

5.4.1.1 Master Node Usage Process 

The associated CANopen slave device profile must first be installed into the system. The device profile can 

be a *.Devdesc.xml file or an EDS (Electronic Data Sheet) file for the manufacturer. 

Install the corresponding CANopen slave device. For example, if the TM series PLC uses CANopen, you need 

to install the expansion module first. The operation steps are as follows: 

Step 1 Double-click ExtCard in the device tree and enter the Settings interface. There is no device option 

by default. 

Figure 5-47 ExtCard Expansion Card Interface 

 

 

Step 2 Select CanOpen. Then the left device tree will automatically add CANbus Bus and 

CANopen_Manager. 
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Figure 5-48 Selecting CANopen Extension 

 

5.4.1.2 Adding a CANopen Slave Node 

Take our DA200 CANopen slave node as an example. Add DA200 slave device under CANopen Manager after 

adding the EDS file of this slave node, as shown in the following diagram. 

Figure 5-49 Device Tree Structure with a CANopen Slave 

 

 

At this time, the software configuration of the CANopen master node is completed. 

5.4.2 CANopen Master Parameter Configuration 

 Network and baud rate configuration parameters 

 Network: the number of CAN networks connected via the CANbus, range: 0–100. 

 Baud rate: the baud rate used for transmission on the bus. Different baud rates can be set (for 

example, 10 kbps, 20 kbps, 50 kbps, 100 kbps, 125 kbps, 250 kbps, 500 kbps, 800 kbps, 1000 kbps). 
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Figure 5-50 CANbus Master Parameter Configuration 

 

 

 Master Configuration Parameters 

CANopen Management is a node under the CANbus node that supports CANbus configuration through 

internal functions. It is generally used as the CANbus master. The configuration page is shown in the 

following figure. 

Figure 5-51 CANopen Master Parameter Configuration 

 

 

 Node ID: It provides an array pair module that CANopen Manager can correspond to one-to-one, with ID 

values of 1-127 (must be a decimal integer). 

 Guarding: Different from node protection, the heartbeat mode is a traditional protection mechanism 

that can be handled by the master and slave modules. Normally, the master is configured to send a 

heartbeat to the slave. 

 Enable heartbeat generation: If this option is enabled, the master will send heartbeats continuously 

according to an internally defined “heartbeat time”. Node ID under Guarding: It is the unique identifier 

of heartbeat generation (1–127) on the bus. 

 Generation time (ms): It defines the internal heartbeat time in milliseconds. 
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6 Diagnosis 

6.1 Diagnosis Overview 

Diagnosis is intended to quickly locate errors that occur during PLC operation and find solutions according 

to the error information and status. The diagnostic interface of Invtmatic Studio can only be obtained and 

displayed after logging in to the PLC. The Invtmatic Studio programming system supports the diagnosis of 

various communication devices and can generate fault information, offline information, and other 

information according to the actual running status of each communication device. The module types 

involved in fault diagnosis mainly include: CPU, Modbus, ModbusTCP, EtherCAT, CANopen, etc. The 

Invtmatic Studio programming system mainly provides four diagnosis routes: configuration diagnosis, 

diagnostic information list, device self-diagnostic information list, and diagnostic programming interface. 

All diagnoses are obtained through fault code analysis, and the fault codes correspond to the diagnostic 

programming interface. 

In the configuration, different icons represent different diagnostic states of each communication module: 

running, standstill, and fault.  

: Indicate the running state. The device has no faults.  

: Indicate the standstill state. The device is not running.  

: Indicate a fault state. In EtherCAT and CANopen, it indicates that a fault has occurred but has been 

recovered. In Modbus, it is displayed as a device in a fault state. 

The running state of the device can be directly viewed in the configuration. 

6.1.1 Fault Diagnosis 

Fault diagnosis can be used to display fault information of all devices, and provide detailed description of 

relevant fault information and methods for troubleshooting the causes. It can also provide more detailed 

diagnostic information for special situations. After the device is connected, double-click Fault Diagnosis 

Summary in the device tree to open the device fault diagnosis interface. 

Figure 6-1 Fault Diagnosis Summary 

 

The Device Type window displays the current fault type and provide the fault display filter function, which 

can display fault information by device type. Device types include CPU module, Modbus module, Modbus 

TCP module, and local module. You can select a different device type, and the diagnostic display list will 

show the corresponding type of diagnosis. All device diagnoses are displayed by default.  

 Search: Search for matching fault information based on the device type or module name. 

 Refresh: Used to refresh device fault information. 

 Clear: Clear the fault information in the table. 
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 Export to EXCEL: Export fault information in the table. 

 Fault Information List: mainly used to display specific module fault information, including device type, 

module name, and fault information. Device Type: Filter a certain type of faulty bus device; 

Module Name: Filter faulty devices with a specific name. 

 Detailed Information window: When a certain piece of fault information is selected in the Fault 

Information List, the detailed information of the fault will be displayed in the detailed information 

window, which includes three options: Error Details, Troubleshooting, and In-depth Diagnosis. The first 

column of Error Details describes the possible cause of the fault, followed by four additional items, 

which are mainly used to provide more information about the fault; Troubleshooting is used to provide 

specific operation methods for cause investigation; and In-depth Diagnosis describes some complex 

errors that require more detailed information for troubleshooting. 

6.2 Device Self-diagnostic Information List 

6.2.1 I/O Diagnosis 

I/O can be added to the CPU local backplane bus. Its diagnostic information is shown as follows. For specific 

error codes and information, please refer to I/O module error codes. 

Figure 6-2 I/O Device Self-diagnostic Information 

 

 

6.2.2 Modbus RTU Diagnosis 

Modbus RTU supports two serial ports: Modbus serial ports 0 and 1. Modbus serial port 0 or 1 can be used as 

a Modbus master or slave. 

When the Modbus serial port is used as a master, slaves (remote slaves) can be added to the master. On the 

slave configuration interface, each slave has an “Error Diagnosis” interface, which details the parameter with 

an error.  

When the Modbus serial port is used as a slave, there is also an “Error Diagnosis” interface to display 

communication errors between the slave and the master. 

6.2.3 Modbus TCP Diagnosis 

The PLC can be used as a Modbus TCP master or slave. When Modbus TCP is used as the master, slaves 

(remote slaves) can be added to the master. On the slave configuration interface, there is an “Error Diagnosis” 

interface, which details the parameter with an error. 

When ModbusTCP is used as a slave, there is also an “Error Diagnosis” interface to display communication 

errors between the slave and the master.  
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6.3 Online Log 

An online log displays program, device, and system-related log information online in real time after 

connection to the PLC device. This function is used to help you quickly locate errors, solve problems timely, 

and ensure the normal operation of the device. 

Login to the PLC: Click Login. When the software and PLC are connected, the log function will be started. The 

log interface is as shown in the figure below. 

Figure 6-3 PLC Log 

 

The meanings of the parameters in the Toolbar of the interface are listed in the table below. 

Parameter Name Parameter Description 

Warning/Error/Exception/Info/Debugging 

Information 

Display and filter different levels of information during 

diagnosis. 

Clear 

Clear the currently displayed diagnostic information. 

After clearing, when there is new log information, the 

system will refresh the latest information. 

Export Export all log information in CSV format. 

Import Import log information. 

Refresh Refresh and view log information. 

All Components 
View the log information of all components, or choose 

to display the log information of a single component. 

Offline log 
Import the saved log information in CSV format in 

offline state. 
  

The meanings of the parameters in the table of the interface are listed in the table below.  

Parameter Name Parameter Description 

Class Display the level of information. 

Time Display the time when the information is generated. 

Description Describe the phenomenon and cause of the error. 

Component Display the component where the error occurred. 
  

6.4 Diagnostic Programming Interface 

The diagnostic interface library CmpErrDiagnose provides a solution for obtaining diagnosis in the user 

program. It can determine the diagnostic information of each device module in the user program and make 

relevant processing. 

The diagnostic programming interface exists in the form of a library and can be added in Library Manager, 

as shown in the figure below. 
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Figure 6-4 Adding a Diagnostic Programming Interface Library 

 

The diagnostic programming interfaces corresponding to CPU, Modbus, ModbusTCP, and backplane I/O are 

provided. Each type of diagnosis corresponds to a set of function blocks for obtaining the corresponding 

error codes. The custom diagnostic results and states in the diagnostic data are displayed in 

ErrCodDataType (as sh in Figure 6-4). For example, Figure 6-5 shows the Modbus master diagnostic function 

block, with three slaves added to the serial port 1. The strRtuDia is declared as a structure array, and each 

array corresponds to the fault information of a slave channel. The diagnostic result is that the slave 1 has 

two channel errors, and slaves 2 and 3 each have one channel error. 

Figure 6-5 Adding a Modbus Master Diagnostic Function Block 
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Figure 6-6 Description of Modbus Master Diagnostic Function Block Parameters 

 

 

6.5 Application Diagnosis 

The programming language used by Invtmatic Studio has the characteristics of high execution efficiency and 

flexible programming, but it also has high requirements on users’ programming ability. When writing 

programs, you need to avoid abnormal operations such as illegal pointer access, division by 0, array out of 

bounds, implicit type conversion, and infinite loops; otherwise, the PLC system may be executed abnormally 

or even crash. This chapter mainly provides troubleshooting methods for exceptions that may occur in the 

PLC. You can refer to them according to actual conditions. 

After compiling a project, the Invtmatic Studio software displays the compilation output error information 

by default. In the compilation output window, you can view the compilation errors. Double-click the error 

display line to locate the error code, as shown in the figure below. 

Figure 6-7 Locating an Error Code 

 

 

Algorithm library error message: Switch to Library Manager by the same method to view the algorithm 

library error message, as shown in Figure 6-8. Open Library Manager, as shown in Figure 6-9. If this library is 

not used, you can delete it; if it is used, you need to install the algorithm library manually. 
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Figure 6-8 Library Manager-related Prompt Messages 

 

 

Figure 6-9 Viewing a Missing Library, and Adding or Removing a Library 

 

 

6.6 Handling of PLC Program Running Exceptions 

6.6.1 Common Exceptions and Solutions 

You may encounter the following exceptions during the process of writing and debugging software: 

 After downloading the program, the programming software cannot scan the corresponding PLC device. 

In this case, you need to set the PLC toggle switch to stop and then power it on again. 

 When you download a program or after running for a period of time, the PLC information display bar 

prompts the error “Program download exception”, as shown in Figure 6-10. 

Figure 6-10 Program Download Exception 

 

 

At this time, you can see that there is a type error on the log interface, and the program cannot run normally, 

as shown in Figure 6-11. 
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When you download the program, a dialog box prompting “Download Failed” pops up, as shown in the figure 

below. 

Figure 6-11 Program Download Failed Prompt Dialog Box 

 

 

Three causes lead to the above exception: 

1. Null pointer (i.e. the pointer value is equal to 0). 

Figure 6-12 Prompt of a Program Download Exception Due to Invalid Pointer Reference 

 

 

2. Division by 0. 
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Figure 6-13 Prompt of a Program Download Exception Due to Division by 0 

 

 

3. Array out of bounds. 

Figure 6-14 Array Out of Bounds 

 

 

For a null pointer and division by 0, the monitor program will directly prompt them when running, but for 

the array out-of-bounds, the program can still run normally. The troubleshooting steps are as follows:  

Step 1 Right-click Application, and select Add Object > POU for implicit checks. 

Figure 6-15 Adding a POU for Implicit Checks 

 

Step 2 On the pop-up interface, check Bound checks and click Add. 
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Figure 6-16 Checking “Bind Check” 

 

 

Step 3 Log in to the PLC, stop the program, add breakpoints in the code “CheckBounds := lower;” and 

“CheckBounds := upper;” of the newly added binding function “CheckBounds”, and activate them 

(press the shortcut key F9). 

Step 4 Run the program. When the array is detected to be out of bounds, the program enters the 

breakpoint, detects the out-of-bounds value (7), and defines the upper limit (3) and lower limit (1) of 

the array, as shown in Figure 6-17. 

Figure 6-17 Program Jumping to a Breakpoint due to Array Out of Bounds 
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Step 5 After locating the problematic program segment, you need to modify the program according to the 

actual situation to avoid exceptions. 

6.6.2 Solutions for PLC Out of Control Due to Program Problems 

Common PLC application problems include: 

 An infinite loop or too many loops occur in the application. 

 The application accesses a null pointer or a pointer out of bounds. 

 The application calls an underlying function block, causing a runtime crash. 

Due to improper program writing, when the program is downloaded to the PLC and started, the PLC 

resources may be exhausted and the Invtmatic Studio software may be unable to control the PLC, resulting 

in failure to scan devices, ping communication errors, connection errors, login errors, or PLC download 

errors. The method to restore the PLC to normal state is as follows: 

Method 1: For a medium-scale PLC, set the RUN/STOP switch to STOP, restart it, scan the PLC, and 

download a correct application. 

Method 2: If the PLC network port can still be pinged, go to the Invtmatic Studio software, locate Tools > 

Invtmatic StudioTools, and click One-click Reset on the factory settings screen to clear the APP. 

Method 3: For the TP series large-scale PLC, download a correct PLC program via a USB flash drive and 

delete the previous application program. The operation steps are as follows: 

Note: When this function is used, the USB flash drive can only have one partition, the controller can only 

connect one USB flash drive, and only one program can be saved in the root directory of the USB flash drive. 

Step 1 After the user program project is opened in the programming software, click Online > Create Boot 

Application in the menu bar. 

 

 

Step 2 Select the startup program APP storage path, keep the default file name unchanged, and click Save. 

 

 



INVT Medium and Large-scale PLC Software Manual  Diagnosis 

202409 (V1.0)  128 

 

 

Step 3 Copy the user startup program files “Application.app” and “Application.crc” to the root directory of 

the USB flash drive.  

 

Step 4 Insert the USB flash drive into any USB port of the controller, power off and restart the controller, 

and wait until the controller RUN indicator light turns on. At this time, the user program is loaded 

successfully. 

Note: After restoring the PLC using the above method, you need to troubleshoot application errors before 

downloading the program. 

6.7 Device Error Codes 

Note: The backplane bus only applies to the TM series PLC. 

Device Error Type Error Location 

Major 

Error 

Code 

Sub-error 

Code 
Error Description 

CPU 

System-re

lated 
Hardware error 0001 

0001 
Button cell not installed or battery 

voltage too low 

0002 
Device supply voltage too low (less 

than 19V) 

System 

component-

related 

Clock system 

component 

error 

0008 

0001 Error in setting time 

0002 Error in writing RTC clock 

0003 Error in reading RTC clock 

IP system 

component 

error 

0009 

0001 
IP segments of IP1 and IP2 

repeated 

XXX Reserved 

0011 
Read: IP1 module - Error in 

opening files 

0012 Read: IP1 module - Unable to get 



INVT Medium and Large-scale PLC Software Manual  Diagnosis 

202409 (V1.0)  129 

Device Error Type Error Location 

Major 

Error 

Code 

Sub-error 

Code 
Error Description 

IP information 

0013 
Write: IP1 module - IP address 

configuration error 

0014 
Write: IP1 module - Mask 

configuration error 

0015 
Write: IP1 module - Gateway 

configuration error 

0016 
Write: IP1 module - Repeated 

segments with USB 

0017 
Write: IP1 module - IP and gateway 

in different segments 

XXX Reserved 

0021 
Read: IP2 module - Error in 

opening files 

0022 
Read: IP2 module - Unable to get 

IP information 

0023 
Write: IP2 module - IP address 

configuration error 

0024 
Write: IP2 module - Mask 

configuration error 

0025 
Write: IP2 module - Gateway 

configuration error 

0026 
Write: IP2 module - Repeated 

segments with USB 

0027 
Write: IP2 module - IP and gateway 

in different segments 

Backplane 

bus 

Backplane 

bus-related 

CPU IO error 0030 

0001 Module configuration error 

0002 
Module parameter configuration 

error 

Digital quantity 

error 
0031 

0001 DI - Module configuration error 

0002 
DI - Module parameter 

configuration error 

XXX Reserved 

2001 DO - Module configuration error 

2002 
DO - Module parameter 

configuration error 

2003 
DO - Module output port power 

supply failure 

2004 DO - Module output error 

XXX Reserved 

XXX Reserved 

Analog 

quantity error 
0032 

0001 Module configuration error 

XXX Reserved 

0012 
AD - Channel 0 parameter 

configuration error 

0015 AD - Channel 0 signal source 
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Device Error Type Error Location 

Major 

Error 

Code 

Sub-error 

Code 
Error Description 

open-circuit 

0016 
AD - Channel 0 sampling signal 

over-limit 

0017 
AD - Channel 0 sampling signal 

above-upper-limit 

0018 
AD - Channel 0 sampling signal 

below-lower-limit 

XXX Reserved 

0022 
AD - Channel 1 parameter 

configuration error 

0025 
AD - Channel 1 signal source 

open-circuit 

0026 
AD - Channel 1 sampling signal 

over-limit 

0027 
AD - Channel 1 sampling signal 

above-upper-limit 

0028 
AD - Channel 1 sampling signal 

below-lower-limit 

XXX Reserved 

0032 
AD - Channel 2 parameter 

configuration error 

0035 
AD - Channel 2 signal source 

open-circuit 

0036 
AD - Channel 2 sampling signal 

over-limit 

0037 
AD - Channel 2 sampling signal 

above-upper-limit 

0038 
AD - Channel 2 sampling signal 

below-lower-limit 

XXX Reserved 

0042 
AD - Channel 3 parameter 

configuration error 

0045 
AD - Channel 3 signal source 

open-circuit 

0046 
AD - Channel 3 sampling signal 

over-limit 

0047 
AD - Channel 3 sampling signal 

above-upper-limit 

0048 
AD - Channel 3 sampling signal 

below-lower-limit 

XXX Reserved 

0003 
Module output port power supply 

failure 

XXX Reserved 

2012 
Channel 0 parameter 

configuration error 
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Device Error Type Error Location 

Major 

Error 

Code 

Sub-error 

Code 
Error Description 

2014 Channel 0 output error 

XXX Reserved 

2022 
Channel 1 parameter 

configuration error 

2024 Channel 1 output error 

XXX Reserved 

2032 
Channel 2 parameter 

configuration error 

2034 Channel 2 output error 

XXX Reserved 

2042 
Channel 3 parameter 

configuration error 

2044 Channel 3 output error 

XXX Reserved 

Temperature 

measuring 

module error 

0033 

0001 Module configuration error 

XXX Reserved 

0012 
Channel 0 parameter 

configuration error 

0015 
Channel 0 signal source 

open-circuit 

0017 
Channel 0 sampling signal 

above-upper-limit 

0018 
Channel 0 sampling signal 

below-lower-limit 

XXX Reserved 

0022 
Channel 1 parameter 

configuration error 

0025 
Channel 1 signal source 

open-circuit 

0027 
Channel 1 sampling signal 

above-upper-limit 

0028 
Channel 1 sampling signal 

below-lower-limit 

XXX Reserved 

0032 
Channel 2 parameter 

configuration error 

0035 
Channel 2 signal source 

open-circuit 

0037 
Channel 2 sampling signal 

above-upper-limit 

0038 
Channel 2 sampling signal 

below-lower-limit 

XXX Reserved 

0042 
Channel 3 parameter 

configuration error 

0045 Channel 3 signal source 



INVT Medium and Large-scale PLC Software Manual  Diagnosis 

202409 (V1.0)  132 

Device Error Type Error Location 

Major 

Error 

Code 

Sub-error 

Code 
Error Description 

open-circuit 

0047 
Channel 3 sampling signal 

above-upper-limit 

0048 
Channel 3 sampling signal 

below-lower-limit 

Fieldbus 
Modbus-rela

ted 

Modbus_RTU 

Master1 
0040 

0001 Illegal function code 

0002 Illegal address 

0003 Wrong number of data 

0004 Slave device failure 

0005 

Communication timeout. An error 

occurs since the communication 

time exceeds the maximum 

communication time set by the 

user 

XXX Reserved 

0008 

Received data frame 

non-conforming to the Modbus 

protocol 

0009 CRC/LRC check error 

XXX Reserved 

000B 

The length of received data does 

not conform to the protocol or the 

number exceeds the maximum 

limit specified by the function 

code 

000C 

The received slave address does 

not match the requested slave 

address 

000D 

The received function code does 

not match the requested function 

code 

000E Instruction execution failed 

Modbus_RTU 

Master2 
0041 

0001 Illegal function code 

0002 Illegal address 

0003 Wrong number of data 

0004 Slave device failure 

0005 

Communication timeout. An error 

occurs since the communication 

time exceeds the maximum 

communication time set by the 

user 

XXX Reserved 

0008 

Received data frame 

non-conforming to the Modbus 

protocol 

0009 CRC/LRC check error 
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Device Error Type Error Location 

Major 

Error 

Code 

Sub-error 

Code 
Error Description 

XXX Reserved 

000B 

The length of received data does 

not conform to the protocol or the 

number exceeds the maximum 

limit specified by the function 

code 

000C 

The received slave address does 

not match the requested slave 

address 

000D 

The received function code does 

not match the requested function 

code 

000E Instruction execution failed 

Modbus_RTU 

Slave1 
0042 

0001 Illegal function code 

0002 Illegal address 

0003 Wrong number of data 

0004 Slave device failure 

0005 

Communication timeout. An error 

occurs since the communication 

time exceeds the maximum 

communication time set by the 

user 

XXX Reserved 

0008 

Received data frame 

non-conforming to the Modbus 

protocol 

0009 CRC/LRC check error 

XXX Reserved 

000B 

The length of received data does 

not conform to the protocol or the 

number exceeds the maximum 

limit specified by the function 

code 

000C 

The received slave address does 

not match the requested slave 

address 

000D 

The received function code does 

not match the requested function 

code 

000E Instruction execution failed 

Modbus_RTU 

Slave2 
0043 

0001 Illegal function code 

0002 Illegal address 

0003 Wrong number of data 

0004 Slave device failure 

0005 
Communication timeout. An error 

occurs since the communication 
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Device Error Type Error Location 

Major 

Error 

Code 

Sub-error 

Code 
Error Description 

time exceeds the maximum 

communication time set by the 

user 

XXX Reserved 

0008 

Received data frame 

non-conforming to the Modbus 

protocol 

0009 CRC/LRC check error 

XXX Reserved 

000B 

The length of received data does 

not conform to the protocol or the 

number exceeds the maximum 

limit specified by the function 

code 

000C 

The received slave address does 

not match the requested slave 

address 

000D 

The received function code does 

not match the requested function 

code 

000E Instruction execution failed 

Modbus 

TCP-related 

 

Modbus TCP 

Master1 
00A0 

0001 Illegal function code 

0002 Illegal address 

0003 Wrong number of data 

0004 Slave device failure 

0005 

Communication timeout. An error 

occurs since the communication 

time exceeds the maximum 

communication time set by the 

user 

XXX Reserved 

0008 

Received data frame 

non-conforming to the Modbus 

protocol 

0009 CRC/LRC check error 

XXX Reserved 

000B 

The length of received data does 

not conform to the protocol or the 

number exceeds the maximum 

limit specified by the function 

code 

000C 

The received slave address does 

not match the requested slave 

address 

000D 
The received function code does 

not match the requested function 
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Device Error Type Error Location 

Major 

Error 

Code 

Sub-error 

Code 
Error Description 

code 

000E Instruction execution failed 

Modbus TCP 

Master2 
00A1 

0001 Illegal function code 

0002 Illegal address 

0003 Wrong number of data 

0004 Slave device failure 

0005 

Communication timeout. An error 

occurs since the communication 

time exceeds the maximum 

communication time set by the 

user 

XXX Reserved 

0008 

Received data frame 

non-conforming to the Modbus 

protocol 

0009 CRC/LRC check error 

XXX Reserved 

000B 

The length of received data does 

not conform to the protocol or the 

number exceeds the maximum 

limit specified by the function 

code 

000C 

The received slave address does 

not match the requested slave 

address 

000D 

The received function code does 

not match the requested function 

code 

000E Instruction execution failed 

Modbus TCP 

Slave1 
00A2 

0001 Illegal function code 

0002 Illegal address 

0003 Wrong number of data 

0004 Slave device failure 

0005 

Communication timeout. An error 

occurs since the communication 

time exceeds the maximum 

communication time set by the 

user 

XXX Reserved 

0008 

Received data frame 

non-conforming to the Modbus 

protocol 

0009 CRC/LRC check error 

XXX Reserved 

000B 
The length of received data does 

not conform to the protocol or the 
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Device Error Type Error Location 

Major 

Error 

Code 

Sub-error 

Code 
Error Description 

number exceeds the maximum 

limit specified by the function 

code 

000C 

The received slave address does 

not match the requested slave 

address 

000D 

The received function code does 

not match the requested function 

code 

000E Instruction execution failed 

Modbus TCP 

Slave2 
00A3 

0001 Illegal function code 

0002 Illegal address 

0003 Wrong number of data 

0004 Slave device failure 

0005 

Communication timeout. An error 

occurs since the communication 

time exceeds the maximum 

communication time set by the 

user 

XXX Reserved 

0008 

Received data frame 

non-conforming to the Modbus 

protocol 

0009 CRC/LRC check error 

XXX Reserved 

000B 

The length of received data does 

not conform to the protocol or the 

number exceeds the maximum 

limit specified by the function 

code 

000C 

The received slave address does 

not match the requested slave 

address 

000D 

The received function code does 

not match the requested function 

code 

000E Instruction execution failed 
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7 PLC Upgrades and Settings 

7.1 Software Upgrade 

After opening the Invtmatic Studio software, click Help > Software upgrade in the menu to enable online 

software upgrades. 

Figure 7-1 Software Upgrade Interface 

 

 

If there is a new version, the software will automatically prompt you to upgrade it when you open it. After 

the download is complete, click Upgrade. 

Figure 7-2 Downloading and Installing the Upgrade Package 
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7.2 Firmware Upgrade 

The TM/TP series supports firmware upgrades via a network port. Click Tools > Invtmatic studio tools in 

the menu. 

Note: The Invtmatic Studio tool can be run as standalone software, and does not require to open the 

Invtmatic Studio programming software, making it easy to use. 

 Communication Connection 

The TM series supports network connection via Ethernet1, Ethernet2, and TypeC, of which Ethernet1 

supports broadcast communication connection (one-click IP scanning and automatic connection). The TP 

series X0 and X1 both support broadcast communication network connection. 

Figure 7-3 PLC Tool Connection Interface 

 

 

 Firmware Upgrade 

You can view the version number or select an upgrade package for upgrades. 

Figure 7-4 Firmware Upgrade Interface 
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7.3 Time Settings 

You can read or modify the system time. 

Figure 7-5 System Time Read/Write Interface 

 

7.4 Network Settings 

Through network settings, you can read or modify the IP address and subnet mask of network ports 1 and 2. 

Figure 7-6 Reading or modifying IP Addresses 

 

7.5 Factory Settings Reset 

Since the PC is connected to Ethernet1 of the PLC, it is not necessary to know the IP address of the PLC. The 

PLC can be reset to factory settings and the APP can be cleared by one click. If multiple PLCs are connected 

to the network, you need to disconnect other PLCs first and connect only the device that needs to be 

restored to factory settings. 



INVT Medium and Large-scale PLC Software Manual  PLC Upgrades and Settings 

202409 (V1.0)  140 

Figure 7-7 Restoring the IP Address or Clearing the Program 

 

 

7.6 File Transfer 

The local computer file directory is displayed on the left side, and the PLC file directory is displayed on the 

right side. It is usually used for users to copy process files. For example, if you want to copy CNC files to the 

PLC, you can select the directory PlcLogic/_cnc. 

Figure 7-8 File Transfer 
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Appendix A Project Examples 

A.1 Example of RS485 Communication Configuration between the 

Controller and Goodrive20 Series VFD 

Set the TM series controller as the master and Goodrive20 series VFD as the slave. The controller uses the 

Modbus RTU communication protocol, with the physical layer of two-wire RS485, and communicates with 

the VFD through the COM2 port. By writing a small program, use the upper computer to read and write the 

function parameters of Goodrive20 VFD. The A1 port of the PLC hardware is connected to the VFD 485+, and 

the B1 port is connected to the VFD 485-. The operation steps are as follows: 

 

Step 1 Create a new project and select the menu Projects > Standard project. At this time, a new standard 

project has been created, the device is TM753, the programming language is structured text (ST), 

and the project information can be edited as needed. 
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Step 2 Add Modbus_Master1 and Modbus_RTU_Slave1 by reference to section 5.2.1 Modbus RTU Master 

Configuration, set the communication parameters, and set the PLC as a Modbus_TCP slave. Then, 

the variables can be displayed on the touch screen. 

 

Step 3 Set the baud rate to 19200, the data bit to 8, the stop bit to 1, the check bit to EVEN (even parity), 

and the timeout period to 1000 ms; set the VFD node number (slave address) to 1, and the slave 

enable variable to 1001. 

 

Step 4 In the Modbus Communication Settings window, add a Modbus slave communication configuration. 



INVT Medium and Large-scale PLC Software Manual  Project Examples 

202409 (V1.0)  143 

 

 

Step 5 Double-click PLC_PRG and enter the following code in the declaration editor to bind the variable 

address, so as to facilitate communication with the touch screen. 

PROGRAM PLC_PRG 

VAR 

 brun_pos AT %MX0.0 :BOOL; // Forward 

 bSet  AT %MX0.1 :BOOL;// Frequency setting start 

 bStop         AT %MX0.2 :BOOL;// Stop 

 brun_neg AT %MX0.3 :BOOL;// Reverse 

 breset  AT %MX0.4 :BOOL;// Error reset 

 bJog_Pos AT %MX0.5 :BOOL;// Forward jog 

 bJog_Neg AT %MX0.6 :BOOL;// Reverse jog 

  

 statusShow  AT %MW100 :INT;// Running state display 

 fre     :INT;// Frequency 

 bstatus    :INT;// Running state 

 hfre         AT %MW10 :INT;// Touch screen frequency value setting 

 canshu     AT %MW200 : ARRAY[1..6] OF INT;  

END_VAR 

In the Modbus slave communication settings window, map the control variables in the program: 

 

In Channel03, read 6 addresses from 16#3000 and map them to the canshu array variable. In the array 

canshu[2], i.e. the address 3002H, if the value 3335 is read, it means that the bus voltage is 333.5 V. Please 

refer to the VFD product manual. 
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In Channel02, read 1 address from 16#2100 and map it to the status Show variable. If the value is 3, it means 

the VFD is stopped. Please refer to the VFD product manual. 

Enter the following code in the main code editor: 

SM1001:=TRUE;// Slave enable variable 

IF brun_pos THEN 

 bstatus:=1; 

END_IF 

IF brun_neg THEN 

 bstatus:=2; 

END_IF 

IF bJog_Pos THEN 

 bstatus:=3; 

END_IF 

IF bJog_Neg THEN 

 bstatus:=4; 

END_IF 

IF bStop THEN 

 bstatus:=5; 

END_IF 

IF bSet THEN 

 fre:=hfre; 

END_IF  

After connecting the VFD to the controller via two-wire RS485, start the VFD. Set the function code P00.01 to 

2 through the VFD keypad so that its running instruction can be controlled by the upper computer through 

communication; set P00.06 to 8, that is, select the Modbus communication mode; set the serial 

communication parameters of the group P14 to make them consistent with the initialization setting 

parameters of the upper computer, including the baud rate, data bit, check bit, slave address, timeout 

period, etc. 

Click the icon  in the Toolbar to compile the code. After completing compilation without errors, click 

the button  in the Toolbar to log in to the controller, and ensure that the Nixie tube of the controller has 

no error, Goodrive20 VFD is successfully connected to the controller, the communication is normal, and the 

touch screen interface is as shown in the figure below. 

A.2 Example of Communication Configuration between the Controller 

and DA200 Series Servo Drive 

Example: By writing a small program, control 4 DA200 series servo drives to drive 4 motor shafts to perform 

uniform forward and reverse motion. The operation steps are as follows: 
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Step 1 Create a new project and select the menu Projects > Standard Project. At this time, a new standard 

project has been created, the device is TM753, the programming language is structured text (ST), 

and the project information can be edited as needed. 

 

 

Step 2 Right-click Device in the device tree, and select Add Device to add an EtherCAT master device, 

EtherCAT Master SoftMotion, Version 3.5.15.30 here. 
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Step 3 Right-click EtherCAT Master SoftMotion in the device tree, and select Add Device to add 4 servo 

drives, DA200-N here. 

 

 

Step 4 Right-click INVT_DA200 in the device tree, select Add Device to add SoftMotion CiA402 Axis, and 

complete the addition of 4 servo motors. 

 

Step 5 Double-click the PLC_PRG and enter the following codes on the statement editor: 

PROGRAM PLC_PRG 

VAR 

 iStatus: INT; 
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 MC_Power_0: MC_Power; 

 MC_Power_1: MC_Power; 

 MC_Power_2: MC_Power; 

 MC_Power_3: MC_Power; 

 MC_MoveAbsolute_0: MC_MoveAbsolute; 

 MC_MoveAbsolute_1: MC_MoveAbsolute; 

 MC_MoveAbsolute_2: MC_MoveAbsolute; 

 MC_MoveAbsolute_3: MC_MoveAbsolute; 

END_VAR 

Step 6 Enter the following code in the main code editor: 

CASE iStatus OF 

0: 

MC_Power_0(Axis:= SM_Drive_GenericDSP402, Enable:= TRUE, bRegulatorOn:= TRUE, 

bDriveStart:=TRUE , ); 

MC_Power_1(Axis:= SM_Drive_GenericDSP402_1, Enable:= TRUE, bRegulatorOn:= TRUE, 

bDriveStart:=TRUE , ); 

MC_Power_2(Axis:= SM_Drive_GenericDSP402_2, Enable:= TRUE, bRegulatorOn:= TRUE, 

bDriveStart:=TRUE , ); 

MC_Power_3(Axis:= SM_Drive_GenericDSP402_3, Enable:= TRUE, bRegulatorOn:= TRUE, 

bDriveStart:=TRUE , ); 

IF MC_Power_0.Status AND MC_Power_1.Status AND MC_Power_2.Status AND 

MC_Power_3.Status THEN 

   iStatus:=iStatus+1; 

END_IF 

1: 

MC_MoveAbsolute_0(Axis:=SM_Drive_GenericDSP402 , Execute:= TRUE, Position:=50 , 

Velocity:=3 , Acceleration:= 2, Deceleration:= 100,); 

MC_MoveAbsolute_1(Axis:=SM_Drive_GenericDSP402_1, Execute:= TRUE, Position:=50 , 

Velocity:=3 , Acceleration:= 2, Deceleration:=100,);  

MC_MoveAbsolute_2(Axis:=SM_Drive_GenericDSP402_2, Execute:= TRUE, Position:=50 , 

Velocity:=3 , Acceleration:= 2, Deceleration:=100,);  

MC_MoveAbsolute_3(Axis:=SM_Drive_GenericDSP402_3, Execute:= TRUE, Position:=50 , 

Velocity:=3 , Acceleration:= 2, Deceleration:=100,);  

IF MC_MoveAbsolute_0.Done AND MC_MoveAbsolute_1.Done AND MC_MoveAbsolute_2.Done 

AND MC_MoveAbsolute_3.Done THEN 

    MC_MoveAbsolute_0(Axis:=SM_Drive_GenericDSP402 , Execute:= FALSE,); 

  MC_MoveAbsolute_1(Axis:=SM_Drive_GenericDSP402_1 , Execute:= FALSE,); 
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    MC_MoveAbsolute_2(Axis:=SM_Drive_GenericDSP402_2 , Execute:= 

FALSE,); 

    MC_MoveAbsolute_3(Axis:=SM_Drive_GenericDSP402_3 , Execute:= 

FALSE,); 

    iStatus:=iStatus+1;  

END_IF 

2: 

MC_MoveAbsolute_0(Axis:=SM_Drive_GenericDSP402 , Execute:= TRUE, Position:=0 , 

Velocity:=3, Acceleration:= 2, Deceleration:= 100,); 

MC_MoveAbsolute_1(Axis:=SM_Drive_GenericDSP402_1, Execute:= TRUE, Position:=0 , 

Velocity:=3 , Acceleration:= 2, Deceleration:=100,);  

MC_MoveAbsolute_2(Axis:=SM_Drive_GenericDSP402_2, Execute:= TRUE, Position:=0 , 

Velocity:=3, Acceleration:= 2, Deceleration:=100,);  

MC_MoveAbsolute_3(Axis:=SM_Drive_GenericDSP402_3, Execute:= TRUE, Position:=0 , 

Velocity:=3 , Acceleration:= 2, Deceleration:=100,);  

IF MC_MoveAbsolute_0.Done AND MC_MoveAbsolute_1.Done AND MC_MoveAbsolute_2.Done 

AND MC_MoveAbsolute_3.Done THEN 

    MC_MoveAbsolute_0(Axis:=SM_Drive_GenericDSP402 , Execute:= FALSE,); 

    MC_MoveAbsolute_1(Axis:=SM_Drive_GenericDSP402_1 , Execute:= 

FALSE,); 

    MC_MoveAbsolute_2(Axis:=SM_Drive_GenericDSP402_2 , Execute:= 

FALSE,); 

    MC_MoveAbsolute_3(Axis:=SM_Drive_GenericDSP402_3 , Execute:= 

FALSE,); 

iStatus:=1; 

END_IF 

END_CASE 

The main body of the program takes the form of a state machine that determines which part of the code to 

execute through the value of iStatus. When the program starts, the iStatus value is 0, and the program 

initializes the MC_Power function block and enables the corresponding motor shaft. If the corresponding 

motor shaft is enabled successfully, the iStatus value is 1 and the program enters the next state. When the 

iStatus value is 1, the MC_MoveAbsolute function block is executed, and the motor rotates to the specified 

position at the specified speed. If the motor moves normally to the specified position, the iStatus value is 

increased by 1, and the motor enters the next state. When the iStatus value is 2, the MC_MoveAbsolute 

function block is executed in the other direction. The motor continues to rotate to the specified position at 

the speed specified by the function block. If the motor moves normally to the specified position, the iStatus 

value is reset to 1. The program is executed repeatedly to implement the forward and reverse movement of 

the motor. 

Step 7 Double-click EtherCAT_Master_SoftMotion from the device tree and click Browse to select the 

corresponding EtherCAT communication network named eth0. Select the distributed clock as 

needed. In this example, select 4000 us as the cycle time. 
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Step 8 Click the button  in the Toolbar to compile the code. After compiling, click the button  in 

the Toolbar to log in to the controller. The servo starts normally, the motor runs smoothly, and the 

upper computer interface is shown in the following figure. 
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Step 9 Double-click INVT_DA200 from the device tree to view or set the current motor running parameters 

in the I/O mapping interface. 

 

 

Step 10 Select Device > PLC Instructions. Click the button  at the lower right corner and select 

plcload. Then the CPU load rate of the current controller will be shown as follows. 

 

To observe the operation of the motor shaft in an intuitive way and track the actual position of the shaft, 

create a new trace. Right-click Application and select Add Object > Trace. Set the task attribute to 

EtherCAT_Task, and add PLC_PRG.MC_Power_0.Axis.fActPosition and 
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PLC_PRG.MC_Power_0.Axis.fActVelocity variables in Trace. Adjust the display properties of the 

coordinates appropriately to track the actual position and actual speed of the motor. 

 

 

A.3 Example of CANopen Communication Configuration between the 

Controller and DA200 Series Servo 

By writing a small program, you can implement CANopen communication to connect DA200 series servo 

drive. The operation steps are as follows: 

Step 1 Create the following project by reference to section 2.1.2 Creating a New Project. 
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Step 2 Click Tools > Device Repository, and then click Install. Locate and click the device profile 

INVT_DA200_CANopen.eds to open it. At this time, DA200 CANopen device profile is added 

successfully. 

 

 

Step 3 Double-click ExtCard in the device tree and enter the Settings interface. There is no device option 

by default. Select CANopen to automatically add CANbus and CANopen_Manager to the left device 

tree. 
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Step 4 Right-click CANopen_Manager in the device tree, select Add Device, and then select the CANopen 

remote device and DA200 Drive. Click Add Device in the lower right corner to add DA200 CANopen 

drive. 

 

Step 5 On the “CANbus” overview interface, the baud rate configuration needs to be consistent with DA200 

CANopen servo (DA200 P4.02); on the “DA200_Drive” overview interface, the node ID configuration 

needs to be consistent with DA200 CANopen servo (DA200 P4.05). 

Step 6 After completing the physical connection of the device, download the program and log in to the 

device. Then, you can see that the CANopen connection to DA200 is successful. 

 

Note: 

 If high real-time performance is required for data, the CAN bus load rate should be less than 30% to 

avoid a small delay in data transmission and reception caused by bus contention. 

 For CAN buses with synchronization requirements, the window length setting value in the bus 

synchronization message should be slightly smaller than the cycle value. 



INVT Medium and Large-scale PLC Software Manual  Project Examples 

202409 (V1.0)  154 

 

 The cycle time of the CANopen task should be slightly longer than the actual execution time of the task. 

 To ensure that the master can monitor the slave normally, check the Heartbeat Enable option in the 

slave. 
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Appendix B SMC_ERROR Description 

Error 

Number 
Module ENUM Variable Description 

0 All function blocks SMC_NO_ERROR No error 

1 DriveInterface 
SMC_DI_GENERAL_COMMUNICAT

ION_ERROR 

Communication error. For 

example, sercos ring has broken 

2 DriveInterface SMC_DI_AXIS_ERROR Axis error 

10 DriveInterface SMC_DI_SWLIMITS_EXCEEDED 
Position output within the 

allowed range (SWLimit) 

11 DriveInterface SMC_DI_HWLIMITS_EXCEEDED Hardware end switch is active. 

13 DriveInterface 
SMC_DI_HALT_OR_QUICKSTOP_

NOT_SUPPORTED 

Drive status Halt or Quickstop is 

not supported. 

14 DriveInterface SMC_DI_VOLTAGE_DISABLED The drive is not enabled. 

15 DriveInterface 
SMC_DI_IRREGULAR_ACTPOSITI

ON 

Current position given from the 

drive seems to be irregular. Check 

the communication 

16 DriveInterface SMC_DI_POSITIONLAGERROR 

Position lag error. Difference 

between set and current position 

exceeds the given limit 

20 

All motion 

generating function 

blocks 

SMC_REGULATOR_OR_START_N

OT_SET 

The controller is not enabled or 

the brake is applied 

21 
Axis in wrong 

controller mode 

SMC_WRONG_CONTROLLER_MO

DE 
Axis in wrong control mode 

30 DriveInterface 
SMC_FB_WASNT_CALLED_DURIN

G_MOTION 

The module created by motion 

control is not called before the 

motion is completed 

31 All function blocks SMC_AXIS_IS_NO_AXIS_REF 
The given AXIS_REF variable is not 

of the type AXIS_REF 

32 
Axis in wrong 

controller mode 

SMC_AXIS_REF_CHANGED_DURI

NG_OPERATION 

AXIS_REF variables have been 

changed while the modules being 

activated 

33 DriveInterface SMC_FB_ACTIVE_AXIS_DIABLED 

The axis is not activated while 

moving 

(MC_Power.bRegulatorOn) 

34 

All motion 

generating function 

blocks 

SMC_AXIS_NOT_READY_FOR_MO

TION 

Axis in its current state cannot 

execute a motion instruction 

40 VirtualDrive 
SMC_VD_MAX_VELOCITY_EXCEED

ED 

Maximum velocity (fMaxVelocity) 

exceeded 

41 VirtualDrive 
SMC_VD_MAX_ACCELERATION_E

XCEEDED 

Maximum acceleration 

(fMaxAcceleration) exceeded 

42 VirtualDrive 
SMC_VD_MAX_DECELERATION_E

XCEEDED 

Maximum deceleration 

(fMaxDeceleration) exceeded 
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Error 

Number 
Module ENUM Variable Description 

50 SMC_Homing 
SMC_3SH_INVALID_VELACC_VAL

UES 

Invalid velocity or acceleration 

values 

51 SMC_Homing 
SMC_3SH_MODE_NEEDS_HWLIMI

T 

Mode requests use of limit 

switches for safety reasons 

70 
SMC_SetControllerM

ode 
SMC_SCM_NOT_SUPPORTED Mode not supported 

71 
SMC_SetControllerM

ode 

SMC_SCM_AXIS_IN_WRONG_STA

TE 

The controller mode cannot be 

changed in the current state 

75 SMC_SetTorque 
SMC_ST_WRONG_CONTROLLER_

MODE 

The axis is under the wrong 

controller mode 

80 
SMC_ResetAxisGrou

p 

SMC_RAG_ERROR_DURING_STAR

TUP 

Error occurs when the axis group 

is activated 

90 
SMC_ChangeGearin

gRatio 
SMC_CGR_ZERO_VALUES Invalid values 

91 
SMC_ChangeGearin

gRatio 
SMC_CGR_DRIVE_POWERED 

The gear ratio parameters of the 

drive cannot be modified when it 

is under control 

92 
SMC_ChangeGearin

gRatio 
SMC_CGR_INVALID_POSPERIOD Invalid position period (≤ 0) 

110 MC_Power SMC_P_FTASKCYCLE_EMPTY 
Axis contains no information in 

the scan cycle (fTaskCycle=0) 

120 MC_Reset SMC_R_NO_ERROR_TO_RESET Axis reset without error 

121 MC_Reset SMC_R_DRIVE_DOESNT_ANSWER Axis does not perform error-reset 

122 MC_Reset 
SMC_R_ERROR_NOT_RESETTABL

E 
Error could not be reset 

123 MC_Reset 
SMC_R_DRIVE_DOESNT_ANSWER

_IN_TIME 

Communication with the axis did 

not work 

130 

MC_ReadParameter, 

MC_ReadBoolParam

eter 

SMC_RP_PARAM_UNKNOWN Parameter number unknown 

131 

MC_ReadParameter, 

MC_ReadBoolParam

eter 

SMC_RP_REQUESTING_ERROR 

Error during parameter 

transmission to the drive. See 

error number in the Programming 

Manual ReadDriveParameter 

(SM_DriveBasic.lib) 

140 

MC_WriteParameter, 

MC_WriteBoolParam

eter 

SMC_WP_PARAM_INVALID 
Parameter number unknown or 

writing not allowed 

141 

MC_WriteParameter, 

MC_WriteBoolParam

eter 

SMC_WP_SENDING_ERROR 

See error number in the 

Programming Manual 

WriteDriveParameter 

(Drive_Basic.lib) 

170 MC_Home 
SMC_H_AXIS_WASNT_STANDSTIL

L 

Axis has not been in standstill 

state 

171 MC_Home 
SMC_H_AXIS_DIDNT_START_HO

MING 
Error at start of homing action 

172 MC_Home SMC_H_AXIS_DIDNT_ANSWER Communication error 
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Error 

Number 
Module ENUM Variable Description 

173 MC_Home 
SMC_H_ERROR_WHEN_STOPPIN

G 

Error at stop after homing. Check 

whether deceleration is set 

180 MC_Stop 
SMC_MS_UNKNOWN_STOPPING_

ERROR 
Unknown error at stop 

181 MC_Stop 
SMC_MS_INVALID_ACCDEC_VALU

ES 

Invalid velocity or acceleration 

values 

182 MC_Stop 
SMC_MS_DIRECTION_NOT_APPLI

CABLE 
Direction=shortest not applicable 

183 MC_Stop SMC_MS_AXIS_IN_ERRORSTOP 
Drive is in errorstop status. Stop 

cannot be executed 

184 MC_Stop 
SMC_BLOCKING_MC_STOP_WAS

NT_CALLED 

An instance of MC_Stop with 

multiple calls 

201 MC_MoveAbsolute 
SMC_MA_INVALID_VELACC_VALU

ES 

Invalid velocity or acceleration 

values 

202 MC_MoveAbsolute SMC_MA_INVALID_DIRECTION Direction error 

226 MC_MoveRelative 
SMC_MR_INVALID_VELACC_VALU

ES 

Invalid velocity or acceleration 

values 

227 MC_MoveRelative SMC_MR_INVALID_DIRECTION Direction error 

251 MC_MoveAdditive 
SMC_MAD_INVALID_VELACC_VAL

UES 

Invalid velocity or acceleration 

values 

252 MC_MoveAdditive SMC_MAD_INVALID_DIRECTION Direction error 

276 
MC_MoveSuperImpo

sed 

SMC_MSI_INVALID_VELACC_VALU

ES 

Invalid velocity or acceleration 

values 

277 
MC_MoveSuperImpo

sed 
SMC_MSI_INVALID_DIRECTION Direction error 

301 MC_MoveVelocity 
SMC_MV_INVALID_ACCDEC_VALU

ES 

Invalid velocity or acceleration 

values 

302 MC_MoveVelocity 
SMC_MV_DIRECTION_NOT_APPLI

CABLE 

Direction=shortest/fastest not 

applicable 

325 MC_PositionProfile SMC_PP_ARRAYSIZE Erroneous array size 

326 MC_PositionProfile SMC_PP_STEP0MS Step time = t#0ms 

350 MC_VelocityProfile SMC_VP_ARRAYSIZE Erroneous array size 

351 MC_VelocityProfile SMC_VP_STEP0MS Step time = t#0ms 

375 
MC_AccelerationPro

file 
SMC_AP_ARRAYSIZE Erroneous array size 

376 
MC_AccelerationPro

file 
SMC_AP_STEP0MS Step time = t#0ms 

400 MC_TouchProbe SMC_TP_TRIGGEROCCUPIED Trigger already active 

401 MC_TouchProbe 
SMC_TP_COULDNT_SET_WINDO

W 

Drive interface does not support 

the window function 

402 MC_TouchProbe SMC_TP_COMM_ERROR Communication error 

410 MC_AbortTrigger SMC_AT_TRIGGERNOTOCCUPIED Trigger already de-allocated 

426 
SMC_MoveContinuo

usRelative 

SMC_MCR_INVALID_VELACC_VAL

UES 

Invalid velocity or acceleration 

values 

427 
SMC_MoveContinuo

usRelative 
SMC_MCR_INVALID_DIRECTION Direction error 

451 SMC_MoveContinuo SMC_MCA_INVALID_VELACC_VAL Invalid velocity or acceleration 
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usAbsolute UES values 

452 
SMC_MoveContinuo

usAbsolute 
SMC_MCA_INVALID_DIRECTION Direction error 

453 
SMC_MoveContinuo

usAbsolute 

SMC_MCA_DIRECTION_NOT_APP

LICABLE 
Direction=fastest not applicable 

600 SMC_CamRegister SMC_CR_NO_TAPPETS_IN_CAM Cam does not contain any tappets 

601 SMC_CamRegister SMC_CR_TOO_MANY_TAPPETS 
Tappet group ID exceeds 

MAX_NUM_TAPPETS 

602 SMC_CamRegister 
SMC_CR_MORE_THAN_32_ACCES

SES 

More than 32 accesses in one 

CAM_REF 

625 MC_CamIN SMC_CI_NO_CAM_SELECTED No cam selected 

626 MC_CamIN 
SMC_CI_MASTER_OUT_OF_SCAL

E 
Master axis out of valid range 

627 MC_CamIN 
SMC_CI_RAMPIN_NEEDS_VELACC

_VALUES 

Velocity and acceleration values 

must be specified for ramp_in 

function 

628 MC_CamIN SMC_CI_SCALING_INCORRECT 

Scaling variables 

fEditor/TableMasterMin/Max are 

not correct 

640 

SMC_CAMBounds, 

SMC_CamBounds_P

os 

SMC_CB_NOT_IMPLEMENTED 
Function block for the given cam 

format is not implemented 

675 MC_GearIn SMC_GI_RATIO_DENOM RatioDenominator=0 

676 MC_GearIn SMC_GI_INVALID_ACC Acceleration invalid 

677 MC_GearIn SMC_GI_INVALID_DEC Deceleration invalid 

725 MC_Phase SMC_PH_INVALID_VELACCDEC 

Velocity and 

acceleration/deceleration values 

invalid 

726 MC_Phase SMC_PH_ROTARYAXIS_PERIOD0 
Rotation axis with fPositionPeriod 

= 0 

750 

All modules using 

MC_CAM_REF as 

input 

SMC_NO_CAM_REF_TYPE 
Type of given cam is not 

MC_CAM_REF 

751 MC_CamTableSelect 
SMC_CAM_TABLE_DOES_NOT_C

OVER_MASTER_SCALE 

Master axis area (xStart and xEnd) 

from CamTable is not covered by 

curve data 

775 MC_GearInPos 
SMC_GIP_MASTER_DIRECTION_C

HANGE 

During coupling of slave axis, 

master axis has changed direction 

of rotation 

800 
SMC_BacklashComp

ensation 
SMC_BC_BL_TOO_BIG 

Gear backlash fBacklash too large 

(> position period/2) 

1000 

CNC function blocks 

which are 

supervising the 

licensing 

SMC_NO_LICENSE Target is not licensed for CNC 

1001 SMC_Interpolator SMC_INT_VEL_ZERO 
Path cannot be processed 

because set velocity = 0 
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1002 SMC_Interpolator SMC_INT_NO_STOP_AT_END Last object of path has Vel_End>0 

1003 SMC_Interpolator SMC_INT_DATA_UNDERRUN 

Warning: GEOINFO List processed 

in DataIn but end of list not 

reached 

Reason: EndOfList of the queue in 

DataIn not be set or 

SMC_Interpolator faster than path 

generating function blocks 

1004 SMC_Interpolator 
SMC_INT_VEL_NONZERO_AT_ST

OP 
Velocity at Stop > 0 

1005 SMC_Interpolator 
SMC_INT_TOO_MANY_RECURSIO

NS 

Too many SMC_Interpolator 

recursions. SoftMotion error 

1006 SMC_Interpolator SMC_INT_NO_CHECKVELOCITIES 

Input-OutQueueDataIn is not the 

last processed function block of 

SMC_CHeckVelocities 

1007 SMC_Interpolator SMC_INT_PATH_EXCEEDED Internal/numeric error 

1008 SMC_Interpolator SMC_INT_VEL_ACC_DEC_ZERO 
Velocity and acceleration / 

deceleration is null or too low 

1009 SMC_Interpolator SMC_INT_DWIPOTIME_ZERO FB called with dwIpoTime = 0 

1050 
SMC_Interpolator2D

ir 

SMC_INT2DIR_BUFFER_TOO_SM

ALL 
Data buffer too small 

1051 
SMC_Interpolator2D

ir 

SMC_INT2DIR_PATH_FITS_NOT_I

N_QUEUE 

Path does not go completely in 

queue 

1100 
SMC_CheckVelocitie

s 

SMC_CV_ACC_DEC_VEL_NONPOS

ITIVE 

Velocity and 

acceleration/deceleration values 

non-positive 

1120 
SMC_Controlaxisbyp

os 

SMC_CA_INVALID_ACCDEC_VALU

ES 

Values of fGapVelocity / 

fGapAcceleration / 

fGapDeceleration non-positive 

1200 SMC_NCDecoder SMC_DEC_ACC_TOO_LITTLE Acceleration value not allowed 

1201 SMC_NCDecoder SMC_DEC_RET_TOO_LITTLE Deceleration value not allowed 

1202 SMC_NCDecoder 
SMC_DEC_OUTQUEUE_RAN_EMP

TY 

Data underrun. Queue has been 

read and is empty 

1203 SMC_NCDecoder 
SMC_DEC_JUMP_TO_UNKNOWN

_LINE 

Jump to line cannot be executed 

because line number is unknown 

1204 SMC_NCDecoder SMC_DEC_INVALID_SYNTAX Syntax invalid 

1205 SMC_NCDecoder 
SMC_DEC_3DMODE_OBJECT_NO

T_SUPPORTED 

Objects are not supported in 3D 

mode 

1300 SMC_GCodeViewer SMC_GCV_BUFFER_TOO_SMALL Buffer too small 

1301 SMC_GCodeViewer 
SMC_GCV_BUFFER_WRONG_TYP

E 
Buffer elements have wrong types 

1302 SMC_GCodeViewer SMC_GCV_UNKNOWN_IPO_LINE 
Current line of the Interpolator 

could not be found 

1500 
All function blocks 

using SMC_CNC_REF 
SMC_NO_CNC_REF_TYPE 

Given CNC program is not of the 

SMC_CNC_REF type 

1501 
All function blocks 

using 
SMC_NO_OUTQUEUE_TYPE 

Given OutQueue is not of the 

SMC_OUTQUEUE type 
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SMC_OUTQUEUE 

1600 CNC function blocks 
SMC_3D_MODE_NOT_SUPPORTE

D 

Function block only works with 

2D paths 

2000 SMC_ReadNCFile SMC_RNCF_FILE_DOESNT_EXIST File does not exist 

2001 SMC_ReadNCFile SMC_RNCF_NO_BUFFER No buffer allocated 

2002 SMC_ReadNCFile SMC_RNCF_BUFFER_TOO_SMALL Buffer too small 

2003 SMC_ReadNCFile SMC_RNCF_DATA_UNDERRUN 
Data underrun. Buffer has been 

read and is empty 

2004 SMC_ReadNCFile 
SMC_RNCF_VAR_COULDNT_BE_R

EPLACED 

Placeholder variable could not be 

replaced 

2005 SMC_ReadNCFile SMC_RNCF_NOT_VARLIST 
Input pvl does not point to a 

SMC_VARLIST object 

2050 SMC_ReadNCQueue SMC_RNCQ_FILE_DOESNT_EXIST File could not be opened 

2051 SMC_ReadNCQueue SMC_RNCQ_NO_BUFFER No buffer defined 

2052 SMC_ReadNCQueue 
SMC_RNCQ_BUFFER_TOO_SMAL

L 
Buffer too small 

2053 SMC_ReadNCQueue SMC_RNCQ_UNEXPECTED_EOF Unexpected end of file 

2100 
SMC_AxisDiagnostic

Log 

SMC_ADL_FILE_CANNOT_BE_OP

ENED 
File could not be opened 

2101 
SMC_AxisDiagnostic

Log 
SMC_ADL_BUFFER_OVERRUN 

Buffer overrun. 

WriteToFile must be called more 

frequently 

2200 SMC_ReadCAM SMC_RCAM_FILE_DOESNT_EXIST File could not be opened 

2201 SMC_ReadCAM SMC_RCAM_TOO_MUCH_DATA Saved cam too big 

2202 SMC_ReadCAM 
SMC_RCAM_WRONG_COMPILE_T

YPE 
Wrong compilation mode 

2203 SMC_ReadCAM SMC_RCAM_WRONG_VERSION Wrong file version 

2204 SMC_ReadCAM SMC_RCAM_UNEXPECTED_EOF Unexpected end of file 

3001 
SMC_WriteDrivePara

msToFile 

SMC_WDPF_CHANNEL_OCCUPIE

D 

SMC_WDPF_TIMEOUT_PREPARIN

G_LIST 

3002 
SMC_WriteDrivePara

msToFile 

SMC_WDPF_CANNOT_CREATE_FI

LE 
File could not be created 

3003 
SMC_WriteDrivePara

msToFile 

SMC_WDPF_ERROR_WHEN_READ

ING_PARAMS 
Error at reading the parameters 

3004 
SMC_WriteDrivePara

msToFile 

SMC_WDPF_TIMEOUT_PREPARIN

G_LIST 

Timeout during preparing the 

parameter list 

5000 SMC_Encoder SMC_ENC_DENOM_ZERO 

Nominator of the conversion 

factor dwRatioTechUnitsDenom 

of the Encoder reference is 0 

5001 SMC_Encoder SMC_ENC_AXISUSEDBYOTHERFB 
Other module trying to process 

motion on the Encoder axis 

5002 DriveInterface 
SMC_ENC_FILTER_DEPTH_INVALI

D 
Filter depth invalid 
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